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Introduction to XBRL User Guide

The IBM Cognos Disclosure Management XBRL User Guide describes how to
perform user tasks in IBM

®

Cognos
®

Disclosure Management XBRL.

Cognos Disclosure Management is a unified financial governance solution that
focuses on improving financial processes and controls, particularly in the final
stages before disclosure. It helps the finance department improve the timeliness
and quality of financial management processes and reporting. Cognos Disclosure
Management also facilitates audits, extends enterprise resource planning (ERP)
transactional controls, and improves financial risk management.

IBM
®

Cognos
®

Disclosure Management XBRL automates the process of eXtensible
Business Reporting Language (XBRL) tagging for compliance with the Security
Exchange Commission mandate as well as other XBRL mandates around the
world.

Features and benefits:
v Enhances the internal controls over financial reporting
v Improves visibility and the audit trail throughout the entire reporting process
v Links source data to report data
v Ability to use a prior report as a template for the next report
v Integrates the Tag Once XBRL function
v Contains tools to promote collaboration
v Delivers workflow and task management tools
v Includes business rules and validation
v Has multiple output options, such as XBRL, EDGAR, HTML, Microsoft Word,

and PDF

Audience

The IBM Cognos Disclosure Management XBRL User Guide is intended for users
who need to work with XBRL tags, XBRL query tags, and tuples, and who need to
generate XBRL instance documents.

Finding information

To find information on the web, including all translated documentation, access IBM
Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Publication date

This document was published on March 1, 2017.

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. IBM® Cognos®

HTML documentation has accessibility features. PDF documents are supplemental
and, as such, include no added accessibility features. For information about these
features, see Appendix A, “Accessibility features,” on page 67 in this document.
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Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any
variation of the Sample Outdoors or Great Outdoors names, and Planning Sample
depict fictitious business operations with sample data used to develop sample
applications for IBM and IBM customers. These fictitious records include sample
data for sales transactions, product distribution, finance, and human resources.
Any resemblance to actual names, addresses, contact numbers, or transaction
values is coincidental. Other sample files may contain fictional data manually or
machine generated, factual data compiled from academic or public sources, or data
used with permission of the copyright holder, for use as sample data to develop
sample applications. Product names referenced may be the trademarks of their
respective owners. Unauthorized duplication is prohibited.
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Chapter 1. What's new

The What's new section contains a list of new, changed, and deprecated installation
and configuration features for this release. It also contains a cumulative list of
similar information for previous releases. It will help you plan your upgrade and
application deployment strategies and the training requirements for your users.

For information about upgrading, see the installation and configuration guide for
your product. To review an up-to-date list of environments supported by IBM
Cognos products, including information on operating systems, patches, browsers,
Web servers, directory servers, database servers, and application servers, visit IBM
Knowledge Center (http://www.ibm.com/support/knowledgecenter).

New features in IBM Cognos Disclosure Management XBRL Version
10.2.6

IBM
®

Cognos
®

Disclosure Management XBRL includes features that were added
since the previous release.

Element Notes tab

In Cognos Disclosure Management Extension Taxonomy Editor, this tab displays
the properties of an element that has possible replacement elements identified with
it (alternate elements), that are included in the definition linkbase, and has a
relationship to the possible replacement element (with custom arc role).

US GAAP 2016 support

US GAAP 2016 is now supported.

New features in IBM Cognos Disclosure Management XBRL Version
10.2.5

IBM
®

Cognos
®

Disclosure Management XBRL includes features that were added
since the previous release.

View XBRL logs

You can view XBRL logs containing a list of facts that have been deleted as a result
of extension taxonomy generation or manual taxonomy replacement in a project.

New features in IBM Cognos Disclosure Management XBRL Version
10.2.3.1

IBM
®

Cognos
®

Disclosure Management XBRL includes features that were added
since the previous release.

© Copyright IBM Corp. 2010, 2016 1
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New guide titled IBM Cognos Disclosure Management Filing
Plugin

The IBM Cognos Disclosure Management Filing Plugin User Guide describes how to
use the IBM

®

Cognos
®

Disclosure Management Filing Plugin to submit to various
regulatory authorities based on filing packages. At the time of publication, the
filing package supports submissions to the European Banking Authority (EBA)
using release frameworks 2.0, 2.1, and 2.2.

Pretagged templates are no longer required for COREP and
FINREP

If you must file reports for various regulatory authorities, you no longer need to
use the pretagged templates that were available in IBM

®

Cognos
®

Disclosure
Management Version 10.2.3. You can now use a filing package instead. The filing
package contains all the needs of the templates in the document titled Implementing
Technical Standard (ITS), which describes the rules for the data that should be
reported, and the timing and method for reporting.

New features in IBM Cognos Disclosure Management XBRL Version
10.2.3

IBM
®

Cognos
®

Disclosure Management includes features that were added since the
previous release.

Refreshing, validating, and generating facts in query tags

If the project supports relational query tagging, you can choose to include or
exclude query items when you refresh and validate data and generate instance
documents.

Editing existing facts and tags

You can now edit existing facts and tags without having to delete the fact or tag
and then create a new fact or tag with the new information

Creating projects for COREP and FINREP

You can create projects that can be used to generate data for submission to COREP
or FINREP.

Seeing dimensions in the Tag Inspector

You can now see the dimensions associated with a tag in the Tag Inspector as well
as the Pivot Grid.

Support for complex typed dimensions

Cognos Disclosure Management XBRL, Version 10.2.3, now supports complex
typed dimensions.

2 IBM Cognos Disclosure Management XBRL Version 10.2.7: User Guide



Replace one aspect with another across an entire project or for
all tags in a certain reporting object

If you are a European user who is required to file reports for COREP (Common
Reporting) or FINREP (Financial Reporting), you can now replace one aspect (for
example, time, unit, decimals, or transformation) with another across an entire
project or for all tags in a certain reporting object or set of reporting objects.

Making simple taxonomy edits without switching to the XBRL
Extension Taxonomy editor

You can now make simple taxonomy edits, such as adding, deleting, or renaming a
label, renaming an element, or changing an element property, without switching to
the XBRL Extension Taxonomy editor.

Automatic detection and creation of Cognos Disclosure
Management projects for your FSR XBRL reports during
migration

When you migrate from FSR to Cognos Disclosure Management, the migration
wizard can now identify and create projects based on the reports that you are
migrating and their XBRL configuration in FSR.

New features in IBM Cognos Disclosure Management XBRL Version
10.2.2.1

Cognos Disclosure Management XBRL includes features that were added since the
previous release.

Pretagged templates for COREP

If you are a European user who is required to file reports for COREP (Common
Reporting) or FINREP (Financial Reporting), you can obtain and import pretagged
templates for the COREP and FINREP systems. IBM can customize pretagged
templates for Cognos Disclosure Management XBRL to meet your particular
requirements.

Custom group filtering

With the new XBRL projects custom groups filter feature, projects are now created
without a default custom group. This feature allows a single project to have tags
associated to one or more custom groups. When users open a project that
represents their instance document, they have the option at that time to filter tags
by one or more custom groups.

Additional jurisdiction added for inline XBRL

If you are using Cognos Disclosure Management XBRL to file for Irish Tax and
Customs, you can now validate and generate inline XBRL for that jurisdiction.

New features in IBM Cognos Disclosure Management Version 10.2.2
IBM

®

Cognos
®

Disclosure Management includes features that were added since the
previous release.
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Tuples

A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. Cognos Disclosure Management XBRL Version
10.2.2 now has the ability to create and manage XBRL tuples when you build an
instance document for a taxonomy that includes tuples.

Inline XBRL

Inline XBRL is a standard for embedding XBRL fragments into an HTML
document. Cognos Disclosure Management XBRL Version 10.2.2 now has the
ability to generate these types of documents.

HMRC validation

In Cognos Disclosure Management XBRL Version 10.2.2, XBRL submissions for
HMRC filers can be validated against SureFile from within the Cognos Disclosure
Management XBRL application.

Support for bidirectional languages

The term bidirectional pertains to scripts such as Arabic and Hebrew that generally
run from right to left, except for numbers, which run from left to right. Cognos
Disclosure Management Version 10.2.2 is now available with Arabic and Hebrew
user interfaces, as well as the ability to generate reports in Arabic and Hebrew.

Generation of charts as images or objects

When you generate a report in Cognos Disclosure Management Version 10.2.2, you
can now choose whether you want to generate charts as images or as objects. If
you choose to generate as an image, it might take less time to process your report,
and this option might result in better rendering of advanced chart types such as
3D charts and rounded edges.

Improved ease of insertion of reference variables

In Cognos Disclosure Management Version 10.2.2, you can now click a button on
the Report Object tab Ribbon to automate the procedure when you must insert a
large number of reference variables into a report.

Improvement to import and export capabilities

Cognos Disclosure Management Version 10.2.2 now has the ability to import and
export data sources and data queries along with the report that uses them.

Migration from Cognos Financial Statement Reporting Version
6.6.1 to IBM

®

Cognos
®

Disclosure Management Version 10.2.2

This standalone migration utility enables existing customers of Cognos Financial
Statement Reporting (FSR) to migrate their existing reports and report object
information to Cognos Disclosure Management XBRL. For more information about
the scope of this utility, see Migrating from IBM Cognos FSR 6 to IBM Cognos
Disclosure Management 10.2.2.
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Chapter 2. Overview of IBM Cognos Disclosure Management
XBRL

XBRL is a communication method for electronic business reporting. IBM
®

Cognos
®

Disclosure Management XBRL uses the XML based framework within XBRL to
provide companies with a standards-based method to prepare, extract, publish,
and exchange financial data.

Although you can use various methods (for example, proprietary file formats,
HTML, Adobe PDF, and flat text files) to transmit business information, the
purpose of using XBRL is to provide a single comprehensive communication
standard.

By putting financial data in an open, agreed upon standard format, XBRL helps
standardize access to financial information over the Internet.

You can now view the interface for Cognos Disclosure Management XBRL in
several languages in addition to English. For more information, see the IBM Cognos
Disclosure Management Installation Guide.

Functionality
In this topic, you can find a list of features and benefits in IBM

®

Cognos
®

Disclosure Management XBRL.

Features and benefits:
v Enhances internal controls over financial reporting
v Improves visibility and audit trail in the entire reporting process
v Links source data to report data
v Uses prior report as a template for the next report
v Integrates Tag Once XBRL function
v Contains tools to promote collaboration
v Delivers workflow and task management tools
v Includes business rules and validation
v Has multiple output options, such as XBRL, EDGAR, HTML, Microsoft Word,

and Adobe PDF

Typical report examples
You can use IBM

®

Cognos
®

Disclosure Management to create various financial
reports for internal or external publication for any organization.

Corporate and regulatory reports often contain repetitive sections that are
time-consuming to reproduce and manage with consistency. Cognos Disclosure
Management enables such reports to be used as templates, which can simplify and
accelerate the process of submitting reports.

© Copyright IBM Corp. 2010, 2016 5



Statutory reporting
In many countries or regions, federal securities laws require publicly traded
companies to disclose information on an ongoing basis. You can use IBM

®

Cognos
®

Disclosure Management to prepare statutory reports.

US regulatory reporting: 10-K, 10-Q, and 20-F

Regulatory bodies such as the Securities and Exchange Commission (SEC) require
businesses to submit annual reports on Form 10-K, and quarterly reports on Form
10-Q for specified events. Businesses must comply with various other disclosure
requirements. Foreign issuers must use Form 20-F to meet disclosure requirements.

The annual report on Form 10-K provides a comprehensive overview of the
company's business and financial condition and includes audited financial
statements. The annual report on Form 10-K is distinct from the annual report to
shareholders.

Form 10-Q includes unaudited financial statements and provides a continuing view
of the company's financial position during the year. The report must be filed for
each of the first three quarters of the company's fiscal year.

Form 20-F is a comprehensive core disclosure document that foreign private issuers
must file annually with the SEC to register securities when they are offered in the
US.

Exhibits specifically refer to attachments that the SEC officially defines in its rules
and regulations. The SEC might require one or more exhibits to be included with a
10-K or 10-Q filing.

Canadian regulatory reporting: annual reports and MD&A

In Canada, public and privately owned corporations are required to produce
annual reports and to disclose important events that affect the business in
Management Discussion and Analysis (MD&A) reports. You can also use Cognos
Disclosure Management for various other required reports.

UK regulatory reporting: annual reports and Form 363

The EU Transparency Directive is designed to bring all European stock exchanges
up to the same level, with a uniform set of rules for Listing and Disclosure that
apply across the European Union. There are more stringent requirements for
interim and annual reports.

In the UK, the Companies House and Financial Services Authority (FSA) requires
businesses to submit various reports and forms on a timely basis. For example, the
Companies House requires an Annual Return (Form 363) to update company
contact information, including contact information for corporate executives, and to
provide a statement of principal business activities.

Corporate and industry reporting
You can use IBM

®

Cognos
®

Disclosure Management to create standard corporate
reports, such as quarterly and annual reports. You can also create industry-specific
reports, such as airline industry reports.
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Quarterly reports, annual reports, and board books

In general, corporations in different countries and regions are required to produce
quarterly and annual reports, displaying financial results for the period. Cognos
Disclosure Management enables consistent report formatting and presentation of
data.

You can also use Cognos Disclosure Management to create and manage content
related to board meeting agenda packets, known as board books.

Airline industry: Form 41

The Form 41 provides valuable information for those who need to analyze and
understand the US airline industry and its member carriers. Form 41 reports on
carrier costs, operations, profit and loss statements, and balance sheets.

Internal reporting
You can use IBM

®

Cognos
®

Disclosure Management to create reports used for
internal control. You can also maintain existing customized reports.

Any report that was built in Microsoft Excel, Microsoft Word, or any presentation
built in Microsoft PowerPoint can be created and maintained in Cognos Disclosure
Management. Additional functionality, such as Workflow and Audit Trail, can then
be applied.
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8 IBM Cognos Disclosure Management XBRL Version 10.2.7: User Guide



Chapter 3. Basic concepts

Before you begin to use IBM
®

Cognos
®

Disclosure Management XBRL, you should
understand some basic concepts.

Important: Using Cognos Disclosure Management XBRL requires a working
knowledge of Microsoft Excel and Microsoft Word. The advanced functionality for
Microsoft products is beyond the scope of this guide; however, some topics are
included for your convenience. For more information, see Microsoft documentation
or Microsoft online help.

IBM Cognos Disclosure Management XBRL interface
The IBM

®

Cognos
®

Disclosure Management XBRL interface is designed to make it
easy for you to perform tasks related to XBRL. Depending on the task that you are
completing, various Ribbons and windows provide the information that you need.

To work with Cognos Disclosure Management XBRL, you need to access the XBRL
interface. Open an XBRL project and, in the Navigation pane, click XBRL to access
the XBRL feature.

Your access to Cognos Disclosure Management XBRL depends on permissions
granted by the administrator.
Related information:
“Adding an XBRL tag to a Word object” on page 33
You can use IBM

®

Cognos
®

Disclosure Management XBRL to add an XBRL tag to
content in a Word object.
“Adding an XBRL tag to an Excel object” on page 30
You can use IBM

®

Cognos
®

Disclosure Management XBRL to tag data in an Excel
object.
“Selecting content from a report object to define a footnote” on page 36
Your Excel and Word objects might contain data or text that you want to use as an
XBRL footnote. You can use IBM

®

Cognos
®

Disclosure Management XBRL to select
that content to define a footnote.
“Adding an XBRL text block” on page 39
A text block is an assembly of one or more sections of text, which might include
escaped HTML, that is drawn from one or more reporting objects in XBRL. You
can use IBM

®

Cognos
®

Disclosure Management XBRL to create a text block from
data in Excel and Word objects.
“Reusing an existing footnote” on page 38
A footnote is a supporting piece of XBRL information that is tied to a fact. If a
footnote was already created from content in Excel and Word objects, you can use
IBM

®

Cognos
®

Disclosure Management XBRL to reuse an existing footnote.

The XBRL Home tab Ribbon
The Home tab in IBM

®

Cognos
®

Disclosure Management XBRL displays Ribbons
that you can use to work with your projects, data, tagging, and footnotes. Each
command group contains a series of commands that you can use to perform tasks
related to that group. The content of the Ribbon varies, depending on the type of
task you are performing.
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Home tab Ribbon for general XBRL tasks

The following commands are available on the Home tab Ribbon when you are not
working specifically with the Pivot Grid or Tuple Explorer:

Table 1. Icons in the XBRL Home tab Ribbon for general XBRL tasks

Icon Name Description

Update
Report View

Used to reload the report object hierarchy to ensure that the
structure is updated in addition to refreshing values on the
report.

Refresh
XBRL

Used to perform a quick or full refresh of XBRL data.

Tag Used to tag data in Excel or Word objects.

Edit Items Used to edit any tag associated with the current selection in
the Pivot Grid.

Negate Items Used to negate any tag associated with the current selection
in the Pivot Grid.

Delete Items Used to delete any tag associated with the current selection in
the Pivot Grid.

Highlight
Tags

Used to highlight Excel data that has been tagged.

Add
Footnote

Used to add a footnote from either the current object
selection or from an existing object.

Delete
Footnote

Used to delete a selected footnote and all its links, to unlink
the selected footnote from the current view, or to unlink the
selected footnote from the selected items.

Search Used to search the Pivot Grid using the following filters:
Concept, Relationship Group, Dimension Member, or
Table.

Validate Used to validate the instance document.

Generate
Inline XBRL

Used to generate an inline XBRL document, if you are
working in a project that is enabled for inline XBRL.

Generate
Instance
Document

Used to generate an instance document, if you are working in
a project that is not enabled for inline XBRL.

Show Tags
in Report

Used to generate a tagging summary report, where you can
review existing tags.

Render in
SEC
Previewer

Used by SEC filers to preview the instance document, where
you can review the document before generation.

Show
Orphan Tags

Used to show all orphan tags in the current project.
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Table 1. Icons in the XBRL Home tab Ribbon for general XBRL tasks (continued)

Icon Name Description

View XBRL
Logs

Used to view a list of XBRL logs related to the current
project.

Home tab Ribbon for XBRL administration tasks

The following commands are available in the XBRL group on the Home tab Ribbon
for XBRL administration tasks.

Important: Access to particular tabs depends on permissions granted by the
administrator. Additionally, depending on your view, certain tabs will be disabled.
For example, the Generate Time Periods icon becomes enabled only if you have
the Time Periods tab open.

Table 2. Icons in the XBRL Home tab Ribbon for XBRL administration tasks

Icon Command Description

Replace Taxonomy Used to replace a project's taxonomy with a
new, mapped similar taxonomy.

Rebuild Search Index Used to build a search index for a taxonomy
that will be used during a search.

Generate Time Periods Used to generate an entire set of commonly
used time periods for a given fiscal year.

Manage Typed Dimensions Used to modify typed dimension values for
dimensions in taxonomies that support
typed dimensions.

Additional XBRL Ribbons
In IBM

®

Cognos
®

Disclosure Management XBRL, you can see different Ribbons in
different situations, depending on the XBRL tasks that you want to perform. The
content of the Ribbons vary, depending on the type of task you are performing.

Pivot Grid tab Ribbon

The following commands are available on the Pivot Grid Ribbon, in the Data
Tools section:

Table 3. Icons in the Pivot Grid Ribbon

Icon Name Description

History Used to restore a previous definition or presentation view
(the relationship group/table/linkbase combination).

Display Used to display your data in the Pivot Grid by presentation
or by definition.

Filter Data Used to filter data that you do not need to see in the Pivot
Grid.

Default
Layout

Used to restore the current Pivot Grid layout to the default
view.
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Table 3. Icons in the Pivot Grid Ribbon (continued)

Icon Name Description

Save Layout Used to save the current Pivot Grid layout.

Load Layout Used to load a previously saved Pivot Grid layout.

Show Pivot
Headers

Used to hide or display the column headers in the Pivot Grid
layout.

Show Units Used to display the unit name with the values in the Pivot
Grid.

Format
Numbers

Used to format how values are represented in the Pivot Grid.

Highlight
Item Types

Used to display the item type allowed in each cell in the
Pivot Grid.

Show
Legend

Used to display a list of item types and the corresponding
color.
Tip: This icon is available only when item types are
highlighted.

Edit
Elements

Used to edit element properties in the Pivot Grid.

Tag Used to create a tag to link data in an Excel or Word object to
an element of a tuple in the Pivot Grid.

Tuple Explorer tab Ribbon

The following commands are available on the Tuple Explorer Ribbon, in the Data
Tools section:

Table 4. Icons in the Tuple Explorer Ribbon

Icon Name Description

Redisplay Used to redisplay tuples in the Tuple Explorer.

Add Used to add a tuple from the taxonomy to the Tuple
Explorer. It can also be used to add a part (Sequence,
Choice, or All) to a tuple when an instance of the tuple is
selected.

Delete Used to delete a selected tuple tag, or to hide a tuple that is
currently visible in the Tuple Explorer.

Move up Used to move parts of a tuple up in their position in the
tuple (for example, for a group that includes firstname and
lastname, you could move firstname to a position above
lastname).
Tip: This icon is available only when a part of a tuple is
highlighted and only in certain situations, as dictated by the
taxonomy.
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Table 4. Icons in the Tuple Explorer Ribbon (continued)

Icon Name Description

Move down Used to move parts of a tuple down in their position in the
tuple (for example, for a group that includes firstname and
lastname, you could move firstname to a position below
lastname).
Tip: This icon is available only when a part of a tuple is
highlighted and only in certain situations, as dictated by the
taxonomy.

Show Units Used to display the unit name with the values in the Tuple
Explorer.

Format
Numbers

Used to format how values are represented in the Tuple
Explorer.

Highlight
Item Types

Used to display the item type allowed in each cell in the
Tuple Explorer.

Show
Legend

Used to display a list of item types and the corresponding
color.
Tip: This icon is available only when item types are
highlighted.

Tag Used to create a tag to link data in an Excel or Word object to
an element of a tuple in the Tuple Explorer.

The Pivot Grid
A pivot grid is an area of the screen that is used to view and interact with the XBRL
instance data. The Pivot Grid in IBM

®

Cognos
®

Disclosure Management XBRL
displays the current view of an XBRL instance document for a project.

The Pivot Grid displays XBRL instance document data for a specified slice of a
dimensional data source. Concepts and their associated dimensions are based on
the taxonomy that is associated with your project. Also other aspects such as entity
identifier and time periods are based on the particular project's associations. This
type of view simplifies tagging XBRL data because you can view or alter how your
data is displayed. Columns and rows can be rearranged or filtered to match the
way that your data is displayed in your own data sources. For example, the
representation of the Consolidated Statement of Earnings relationship group can be
altered to resemble your source Excel object.

The Concept, Time, and Entity axes are standard axes that are always displayed.
There might be more axes that are defined in your taxonomy that are displayed
with their Label followed by the text "[Axis]". By default, axes that are defined in
your taxonomy are initially displayed as column headers.

Displaying data in the Pivot Grid

Before you can view or tag data, you must specify the slice of the XBRL instance
document that you want to work with.

If you already know which business concept, relationship group, dimension
member, or table you must work with, you can use Search to locate the data.
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You can also open your project and use the Select data area to select values for the
Relationship Group and Table fields. Then, click Display by Presentation or
Display by Definition to populate the Pivot Grid. Depending on the relationship
group that you select, you might or might not need to select a table. When you
select Display by Definition, a table must be selected.

You can use the History button to list the most recently displayed slices for the
current project. Clicking an item in the history refreshes the Pivot Grid with the
selected item. You can pin an item in the list so that it always appears at the top of
the list.

Manipulating columns and rows

A pivot header represents a dimension, which can be hierarchical. For example, the
Concept axis signifies the hierarchies in a dimension as defined by the associated
taxonomy linkbase, presentation or definition. By default, the concept axis is
displayed down the side as row headers and the time axis is displayed as column
headers. The display of hierarchies is determined by the selection of Display by
Presentation or Display by Definition.

You can change the sort order of each pivot header. Click the up or down arrow
beside the name of the header in the header button to change the order. You can
also click the arrow that is between header buttons to expand or collapse fields in
the Pivot Grid.

You can rearrange axes in the Pivot Grid by clicking and dragging a pivot header
to a different location to view the data in a different way. For example, you might
want to display time down the side and your concepts across the top.

Hovering over a member of a dimension that forms an axis displays the details of
that member. For example, hovering over a time period member displays the start
and end dates and the name for the time period. User dimensions are based on the
taxonomy that is associated with the project and can include explicit and typed
dimensions. Explicit dimensions are defined in the taxonomy schema, and typed
dimension values are defined by users. Hovering over a member of a typed
dimension displays the XML representation of that member.

Figure 1. Pivot Grid view with concept and time axis
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Viewing concept details

A concept is a description of information in XBRL. If you hover over a concept, you
can see details including the equivalent XBRL element name and ID, and the
namespace that it belongs to.

Viewing fact data

A fact is a specific piece of information described by a concept in XBRL. The Pivot
Grid displays financial reporting data (facts) at the intersections of all the
dimensional axes that form the selected table. A Pivot Grid intersection might have
one of the following appearances:
v Empty
v Value
v Gray highlight
v Red highlight

An empty intersection indicates that it has not been tagged to source data from a
report object.

A value is present if the intersection was previously tagged to qualified data from
a report object.

Intersections are highlighted in gray when tagging is not allowed. For example, if a
concept is filtered to hide its child concepts, the Pivot Grid intersection that is
associated with the parent concept is gray.

Intersections are highlighted in red when they contain an error, such as multiple
tags with conflicting values.
Related information:
“XBRL tags” on page 29
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. You can use IBM

®

Cognos
®

Disclosure Management XBRL to
tag data that exists in Excel objects, Word objects, and relational data queries.
Tagging comes in the following forms: normal tagging for normal items, text block
tagging, and footnote tagging.
“Selecting content from a report object to define a footnote” on page 36
Your Excel and Word objects might contain data or text that you want to use as an
XBRL footnote. You can use IBM

®

Cognos
®

Disclosure Management XBRL to select
that content to define a footnote.
“Adding an XBRL text block” on page 39
A text block is an assembly of one or more sections of text, which might include
escaped HTML, that is drawn from one or more reporting objects in XBRL. You
can use IBM

®

Cognos
®

Disclosure Management XBRL to create a text block from
data in Excel and Word objects.
“Reusing an existing footnote” on page 38
A footnote is a supporting piece of XBRL information that is tied to a fact. If a
footnote was already created from content in Excel and Word objects, you can use
IBM

®

Cognos
®

Disclosure Management XBRL to reuse an existing footnote.
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Manipulating the Pivot Grid
When you use IBM

®

Cognos
®

Disclosure Management XBRL to add XBRL tags to
data in Excel and Word objects, you use the Pivot Grid. You can view the data in
the Pivot Grid in the default view, or you can manipulate the data display to meet
your needs.

Procedure
1. In the File tab, double-click the Projects icon.
2. Double-click the project that you want to open.
3. In the Select data group, complete the Relationship Group and Table fields,

and click Display. Depending on the relationship group that you select, it
might not be necessary to select a table. A filter tree is displayed, displaying the
entity, time, explicit dimension, and typed dimension axes, along with the child
elements of each axis.

Important: If you are loading a saved layout, the filter tree is not displayed.
The Pivot Grid opens immediately.

4. Clear items in the filter tree to hide those elements that you do not want to
display in the Pivot Grid.
Changing the status of a parent element changes the status of its child
elements.
v If the entity axis has only one member, it is selected and cannot be cleared.

There must be at least one entity to display the Pivot Grid.
v If the time axis has only one member, it is selected and cannot be cleared.

There must be at least one time period to display the Pivot Grid.
5. Click the Filter Data check box to clear it and display the Pivot Grid.

You can toggle between the filter tree and the Pivot Grid at any time by
clicking the Filter Data check box

6. You can change the order of the rows under each header. Click the arrow
beside the name of the header to reverse the order. Click it again to return to
the original order.

7. You can rearrange the rows and columns in the Pivot Grid to view the data in
a different way. You can rearrange the rows and columns in the Pivot Grid to
change the view to make it more similar to data in your report object.
v If data currently is displayed in a column, drag its header from the column

area to the row area.
v If data currently is displayed in a row, drag its header from the row area to

the column area.
v When you drag the headers, click the square box for the header, not any of

the arrows that are associated inside or outside of the box.
v When you arrange one column to a row, you must also bring the content

that was in the row to the column area.
8. Click Save Layout to save the Pivot Grid.

What to do next

After you arrange the data in the Pivot Grid in the way that meets your needs,
you can proceed to add or delete tags, text blocks, and footnotes.
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Searching in the Pivot Grid
You can search within the Pivot Grid in IBM

®

Cognos
®

Disclosure Management
XBRL to quickly find relationship groups and tables that satisfy criteria that you
select.

Procedure
1. In the File tab, double-click the Projects icon.
2. Double-click the project that you want to open.
3. In the Select data group, select a project in the Project, field, and click Search.

The Search tab opens.
4. Type a search term in the search box.
5. You can filter the search results by selecting the Concept, Relationship Group,

Dimension Member, or Table icons.
6. Click an item in the search results to open the corresponding relationship

group.

Special search syntax:

You can use wildcards and special search terms to make your searches more
efficient in IBM

®

Cognos
®

Disclosure Management XBRL.

Wildcards

You can use an asterisk (*) as a placeholder for any character string.

RoleHasConcept and TableHasMember filters

You might know the intersection (concept and dimension member) that you want
to tag against and you want to go straight to the Pivot Grid that has that
intersection. For example, you might want to tag the concept “net income” against
the member “Canada”.

You can type the following search string:

Canada RoleHasConcept:"net income"

This search string searches on the “Canada” member with relationship groups that
only contain the “net income” concept. This search filters out any relationship
groups that do not contain “net income”.

You can type the following query:

"net income" TableHasMember:Canada

This query searches on the “net income” concept with tables that only have the
“Canada” member. This search filters out any tables that do not contain “Canada”.

Exact matches

The search string net income matches all search results that contain either “net” or
“income”. To obtain search results that contain only “net income”, use the search
string "net income".
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Type search

You can filter the document type in the search results by using the
“type:<document_type>” keyword. For example, you can type the following search
string:

"net income" type:concept

This search string returns search results that are restricted to concepts.

<document_type> can be concept, role, domainmember, or table.

The Tag Inspector tab
In the Tag Inspector tab in IBM

®

Cognos
®

Disclosure Management XBRL, you can
view specific information about your XBRL tags.

Buttons in the Tag Inspector tab

The Tag Inspector tab provides specific information about your tags, including the
dimensions associated with each tag.

In the Tag Inspector tab, you can click the following buttons to view and manage
your tagged items:

Show all tags in the following location
This button updates the content in the Tag Inspector tab based on the
button that you click:

Project
All the tags from the project are refreshed from the server and are
listed in the Tag Inspector tab.

Data Area
All the tags that are currently associated to items in the Pivot Grid
are listed in the Tag Inspector tab.

Data Area Selection
Select items in the Pivot Grid. Tags that are currently associated to
the selected items in the Pivot Grid are listed in the Tag Inspector
tab.

Report Object
All the tags that are currently in the report object are listed in the
Tag Inspector tab.

Report Object Selection
Select items in the report object. All the tags that are currently in
the selected area of the report object are listed in the Tag Inspector
tab.

Update from Selection
Highlight a tagged item in the list and then click this button. Depending
on the content that you selected in the Show all tags in the following
location filter, you can update content with the Update from Selection
button.

Show in Report Object
Highlight a tagged item in the list and then click this button. You can see
the tag as it appears in the source report object.
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Show in Data Area
Highlight a tagged item in the list and then click this button. You can see
the tag as it appears in the Pivot Grid. If it appears in more than one place
in the Pivot Grid, you can select the location that you want to see.

Edit Highlight a tagged item in the list and then click this button. You can edit
the tag of an item directly in the Tag Inspector tab.

Delete Highlight a tagged item in the list and then click this button. You can
delete the tag of an item directly from the Tag Inspector tab.

Columns in the Tag Inspector tab

You can use the columns in the Tag Inspector tab to view a great deal of detailed
information about the tags in your project. You can find additional information
about the Dimensions column later in this topic.

You can sort the columns in ascending or descending order by clicking the column
header. You can also drag a column to the upper area of the pane to group by that
column.

Concept
Lists the specific tagged item. If you cannot see the full content of the field,
you can slide the border of the column to make the field wider, or you can
hover your mouse over the truncated content for details.

Name The name of the tag.

Prefix The prefix of the tag.

Type The type of tag.

Period The period of the tag.

Balance
The balance of the tag.

Unit The monetary type, for example, USD.

Entity The name of the entity.

Time Period
The specified time period of the tagged item.

Value The tag's value as it appears in the Pivot Grid with any transformations
that might have been applied.

Source Value
The last known value in the report object as it appears prior to
transformation (if any).

Accuracy
This field is applicable only to a numerical concept.

Transformation Set
Lists the transformation set associated with the item.

Negated
Indicates if the tag's value has been negated.

Report Object Name
This is the name of your report object and is the tag's source.
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Dimensions column

In the Dimensions column, you can view information about all dimensions related
to a particular tag: explicit dimensions, simple typed dimensions, and complex
typed dimensions. In a list of multiple dimensions, each dimension is delimited by
the pipe symbol ( | ). If you work with COREP or FINREP taxonomies, you might
find this column particularly useful.

Explicit dimensions
Explicit dimensions are dimensions that come from the taxonomy. You can
view explicit dimensions in the data area and also in the Dimensions
column of the Tag Inspector tab.

Simple typed dimensions
If your project supports typed dimensions, they are created by users who
have administrative permissions. Simple typed dimensions contain one
level of XML. You can view simple typed dimensions in the data area and
also in the Dimensions column of the Tag Inspector tab. For more
information, hover your mouse on the specific cell in the Dimensions
column. You can now view all dimensions that are associated with the tag.
Each line in the tooltip represents a different dimension.

Complex typed dimensions
If your project supports typed dimensions, they are created by users who
have administrative permissions. Complex typed dimensions contain
multiple levels of XML. You can view complex typed dimensions in the
data area and also in the Dimensions column of the Tag Inspector tab. For
more information, hover your mouse on the specific cell in the
Dimensions column. You can now view all complex type dimensions that
are associated with the tag in XML format.

The Footnotes tab
In the Footnotes tab in the IBM

®

Cognos
®

Disclosure Management XBRL interface,
you can view information about the footnotes in your project.

The Footnotes tab provides specific information about your footnotes. The
Footnotes tab contains details of new footnotes and any other existing footnotes in
the Pivot Grid. When you click the number in the Pivot Grid intersection, you can
navigate to the footnote in the Footnotes tab. You can also delete a footnote from
the Footnotes tab.

The Validation Messages tab
In the Validation Messages tab in the IBM

®

Cognos
®

Disclosure Management XBRL
interface, you can view information about the most recent validation process.

The Validation Messages tab provides specific information about the validations
that you run on your XBRL content. When you validate XBRL content, the
Validation Messages tab displays any conflicts. When you add an XBRL query tag,
and the query tag was not created properly, an exclamation mark in the All
processes completed window indicates any error that stopped the query tag
creation, and the Validation Messages tab displays any errors.
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Taxonomy overview
A taxonomy is a description of a multidimensional data store expressed in XML. To
create XBRL files in IBM

®

Cognos
®

Disclosure Management, an administrator must
use a taxonomy.

Generally, a taxonomy is a body of concepts that are systematically defined and
classified into ordered groups according to relationships between the individual
items of information. In accounting, different taxonomies are created (for example,
US GAAP) according to the statutory reporting requirements of the country, region,
or industry.

For example, in a balance sheet template, different elements are defined and
classified so that accountants understand both the meaning of individual line items
and the relationships between them. However, a balance sheet is only part of the
usual reporting requirements. The additional information that is required to
produce full financial statements (including notes, director's report, and auditor's
report) is represented in the taxonomy.

Extension taxonomy overview
An extension taxonomy is an extension of a base taxonomy that includes all the
changes that are required for the specific reporting requirements of an entity. You
can use Cognos Disclosure Management Extension Taxonomy Editor to create
extension taxonomies for use in IBM

®

Cognos
®

Disclosure Management XBRL.

An extension taxonomy extends a base taxonomy (for example, US GAAP), with
all the changes required for an entity's specific reporting needs.

Project overview
A project is a framework for holding the data and metadata that refers to an XBRL
instance document. You can use IBM

®

Cognos
®

Disclosure Management XBRL to
manage a project.

A project is a container that is used to store the tags that make up an instance
document. Before you can perform tagging in XBRL, you must first create a
project. When you create the project, you associate it with a taxonomy and a
report. After the project is created, you then associate aspects with it (time periods,
units and measures, and entity identifiers).

A project is associated with one report. A report can be associated with multiple
projects so that you can produce multiple instance documents from one report.
Related information:
“Opening an XBRL project”
Before you can perform tagging in IBM

®

Cognos
®

Disclosure Management XBRL,
you must first create a project.

Opening an XBRL project
Before you can perform tagging in IBM

®

Cognos
®

Disclosure Management XBRL,
you must first create a project.
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About this task

This procedure is a prerequisite for any tagging task in Cognos Disclosure
Management XBRL.

Important: If you are creating a project that uses a COREP or FINREP taxonomy,
Cognos Disclosure Management XBRL automatically detects the taxonomy
namespace associated with COREP or FINREP, and it sets up the project
accordingly.

Procedure
1. In the File tab, double-click the Projects icon.
2. Select the project that you want to open.
3. In the Preview pane, click Open.
4. Choose one of the following:
v Open - to open the project without using custom group filtering.
v Open a Report Filtered by Custom Groups - to open the project using

custom group filtering. In the Open a Report Filtered by Custom Groups
window, select one or more custom groups with which you want to filter the
project. Click OK. The project opens and displays only those report objects in
the associated report to which the custom groups you selected were
previously applied.

5. In the Select data group, complete the Role and Table fields, and click
Display. If no dimensions are associated with the role that you select, it is not
necessary to select a table. The Pivot Grid opens.

What to do next

You can now proceed to add, edit, or delete tags in Cognos Disclosure
Management XBRL.
Related information:
“Project overview” on page 21
A project is a framework for holding the data and metadata that refers to an XBRL
instance document. You can use IBM

®

Cognos
®

Disclosure Management XBRL to
manage a project.

Report object overview
A report object is a type of content in a report. Report objects represent most of the
content of your report in IBM

®

Cognos
®

Disclosure Management.

There are five types of report objects: Excel, Word, PowerPoint, Web Page, and
PDF. If you are the administrator, you can add report objects to any report.

Transformations and transformation sets
You can use transformations to tag different types of inputs from an Excel object in
IBM

®

Cognos
®

Disclosure Management XBRL.

You can set a transformation to change a string, date, or numeric value to a certain
format, value, or text output.

You can concatenate transformations so that the output of the previous
transformation is the input to the next transformation in a transformation set.
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Related information:
“Adding an XBRL tag to an Excel object” on page 30
You can use IBM

®

Cognos
®

Disclosure Management XBRL to tag data in an Excel
object.
“Adding an XBRL tag to a Word object” on page 33
You can use IBM

®

Cognos
®

Disclosure Management XBRL to add an XBRL tag to
content in a Word object.

XBRL tagging overview
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. When a taxonomy is available, you can use IBM

®

Cognos
®

Disclosure Management XBRL to tag items of business data to build an instance
document.

Tagging is the process of associating individual taxonomy elements with
identifiable items of business data in a report. After tagging your data, use Cognos
Disclosure Management XBRL to generate an instance document that you can
submit to your regulatory body.

You can view information about your XBRL content in the Pivot Grid and in the
following three tabs:
v Tag Inspector tab
v Footnotes tab
v Validation Messages tab
Related information:
“Adding an XBRL text block” on page 39
A text block is an assembly of one or more sections of text, which might include
escaped HTML, that is drawn from one or more reporting objects in XBRL. You
can use IBM

®

Cognos
®

Disclosure Management XBRL to create a text block from
data in Excel and Word objects.
“Reusing an existing footnote” on page 38
A footnote is a supporting piece of XBRL information that is tied to a fact. If a
footnote was already created from content in Excel and Word objects, you can use
IBM

®

Cognos
®

Disclosure Management XBRL to reuse an existing footnote.
“Selecting content from a report object to define a footnote” on page 36
Your Excel and Word objects might contain data or text that you want to use as an
XBRL footnote. You can use IBM

®

Cognos
®

Disclosure Management XBRL to select
that content to define a footnote.
“Adding an XBRL tag to an Excel object” on page 30
You can use IBM

®

Cognos
®

Disclosure Management XBRL to tag data in an Excel
object.
“Adding an XBRL tag to a Word object” on page 33
You can use IBM

®

Cognos
®

Disclosure Management XBRL to add an XBRL tag to
content in a Word object.
“Using negation to reverse the sign of tagged items” on page 41
You can reverse the sign of a value in IBM

®

Cognos
®

Disclosure Management XBRL
from positive to negative or from negative to positive when you generate the
instance document. For example, if your data contains a negative numeric value
(for example, for Cost of Sales), you might want to express it as a positive
number.
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Tuple tagging overview
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

For example, a tuple called Director might contain simple elements called
firstname and lastname. If the name information appears in a report object in
Cognos Disclosure Management XBRL, you can link the information in the report
object to the tuple elements by creating tuple tags.
Related information:
“Adding a tuple from the taxonomy” on page 47
If a particular tuple exists in your taxonomy, but you cannot see it in the user
interface in IBM

®

Cognos
®

Disclosure Management XBRL. it might be hidden. You
can use Cognos Disclosure Management XBRL to add it to the user interface.
“Deleting a footnote from a tuple” on page 51
If you no longer need a footnote that is attached to a tuple, you can use IBM

®

Cognos
®

Disclosure Management XBRL to delete it.
“Hiding a tuple” on page 48
If you do not plan to use a particular tuple, you can use IBM

®

Cognos
®

Disclosure
Management XBRL to hide it. The tuple will still exist in your taxonomy, but it will
no longer be visible in the user interface, and will therefore not appear in the
ouput instance document.
“Adding a tuple tag to an Excel or Word object” on page 49
You can use IBM

®

Cognos
®

Disclosure Management XBRL to add a tag to a tuple in
your taxonomy. The source of the data can be an Excel object or a Word object.
“Adding a footnote to a tuple tag” on page 50
Your Excel and Word objects might contain data or text that you want to use as a
footnote to a tuple tag. You can use IBM

®

Cognos
®

Disclosure Management XBRL
to create a new footnote for a tuple tag, or to add an existing footnote to multiple
tuple tags.
“Deleting a tuple tag” on page 50
If you no longer need a tuple tag, you can use IBM

®

Cognos
®

Disclosure
Management XBRL to delete it.

EDGAR HTML overview
You can use the HTML tools for Electronic Data Gathering, Analysis, and Retrieval
(EDGAR) in IBM

®

Cognos
®

Disclosure Management to preview your HTML file for
the SEC.

You can use Cognos Disclosure Management to generate valid EDGAR content for
the SEC in two ways.
v You can generate HTML output. You can find information on this method in this

documentation.
v You can generate output that conforms with SEC EDGAR Filer Manual rules.

The EDGAR Filer Manual validates that the taxonomy and instance document
comply with the rules. You can find information on this method in the IBM
Cognos Disclosure Management XBRL User Guide.

Important: In previous versions of Cognos Disclosure Management
documentation, the information about how to generate HTML output for EDGAR
was contained in a separate guide titled IBM Cognos Disclosure Management
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EDGAR. The IBM Cognos Disclosure Management EDGAR guide is now obsolete,
and its contents have been moved into the IBM Cognos Disclosure Management User
Guide.
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Chapter 4. XBRL tasks

You can use IBM
®

Cognos
®

Disclosure Management XBRL to perform all the tasks
that you need for your XBRL files.

You build an XBRL file by associating the taxonomy with the IBM
®

Cognos
®

Disclosure Management report, and attaching individual taxonomy elements to
identifiable items of business data. This process is referred to as tagging.

When an XBRL file is built from tagged elements in Cognos Disclosure
Management XBRL, the attributes and relationships that are defined in taxonomy
elements are automatically attached to the tagged data items. Users can build
meaningful information without being constrained by data aggregation
considerations or particular report formats, and can therefore address multiple
reporting demands with a single XBRL file.

Preparing to submit XBRL
You can use IBM

®

Cognos
®

Disclosure Management XBRL to prepare XBRL data for
submission to the SEC.

About this task

To get XBRL data ready for submission, you must follow the following main steps.

Procedure
1. Identify and document the individual taxonomy concepts that best match the

concepts that are disclosed in the company financial statements and disclosures.
Review and approve all concept selections.
v Compare and map the source document:

– Obtain the financial statement (with or without footnotes).
– Identify the facts to be tagged.
– Compare and match against elements in the taxonomy.
– Identify elements not available in the taxonomy.

2. Create the company extension taxonomy as an extension of the US GAAP
taxonomy.
v Create relationship groups for company statements, disclosures, and

parentheticals.
v Add company-specific elements.
v Model company statements and disclosures in the new groups:

– Create new element relationships.
– Change the ordering of elements to reflect the company financial

statements.
– Select preferred labels for presentation.

v Create company-specific presentation labels for elements.
v Create mathematical validations.
After the extension taxonomy is created, validate the extension against SEC
EDGAR File Manual Rules, and make sure that selected concepts are included.
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3. Associate the fact values being reported in a particular filing with specific
elements in the company taxonomy:
v Determine appropriate taxonomy, context, units of measure, and scale.
v Tag financial statement reporting facts with taxonomy elements.
v Assure conformance with SEC EDGAR Filer Manual Rules.
This procedure includes defining periods, units of measure, and other aspects
specific to that report. After elements are tagged, validate the tagging against
the SEC EDGAR Filer Manual Rules and make sure that correct concepts are
used.

4. Build the XBRL tagged and formatted document that is submission-ready for
the SEC:
v Generate the instance document.
v Validate against the SEC EDGAR Filer Manual Rules.
v Review rendering with the SEC Private Previewer.

5. Validate the instance document against the SEC EDGAR Filer Manual Rules,
and use the SEC Previewer to review rendering and perform test submission.

Edit taxonomy elements
You can use IBM

®

Cognos
®

Disclosure Management XBRL to edit taxonomy
element properties and labels in the pivot grid without using Cognos Disclosure
Management Extension Taxonomy Editor.

An element is a basic unit consisting of a start tag, end tag, associated attributes
and their values, and any text that is contained between the two. You can edit
properties for elements such as name, ID, balance, period type, type, and abstract
value. Additionally, you can add, edit, or delete required label properties (label
text, label type, language). Taxonomy editing is described fully in the IBM Cognos
Disclosure Management Extension Taxonomy Editor User Guide.

Editing taxonomy elements in the pivot grid
You can use IBM

®

Cognos
®

Disclosure Management XBRL to edit taxonomy
element properties and labels in the pivot grid.

Before you begin

Before you can edit taxonomy element properties and labels in Cognos Disclosure
Management XBRL, you must be using a taxonomy in the pivot that is editable
(meaning it has an associated taxonomy in the taxonomy editor) and that you have
permission to edit taxonomies and tag data.

About this task

You can edit properties for elements such as name, ID, balance, period, type, and
abstract value. Additionally, you can add, edit, or delete required label attributes
(label text, label type, language). Taxonomy editing is described fully in IBM
Cognos Disclosure Management Extension Taxonomy Editor User Guide.

Procedure
1. Open the project that you want to work with.
2. Use the Select data area to select values for the Relationship Group and Table

fields. Depending on the relationship group that you select, you might or might
not need to select a table.
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3. Click Display by Presentation or Display by Definition to populate the Pivot
Grid. When you select Display by Definition, a table must be selected.

4. In the Pivot Grid, select the filters to use and click Apply. ThePivot Grid is
populated.

5. Click Edit Elements. The Edit Element Attributes window opens.
6. Select an element, make your edits, and click OK. A message is displayed in

the Pivot Grid notifying you that the taxonomy associated with your current
project has been updated and thePivot Grid needs to be redisplayed.

7. Click Display now. The Pivot Grid is redisplayed.

What to do next

You can continue to work with the project or close it.

XBRL tags
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. You can use IBM

®

Cognos
®

Disclosure Management XBRL to
tag data that exists in Excel objects, Word objects, and relational data queries.
Tagging comes in the following forms: normal tagging for normal items, text block
tagging, and footnote tagging.
Related information:
“The Pivot Grid” on page 13
A pivot grid is an area of the screen that is used to view and interact with the XBRL
instance data. The Pivot Grid in IBM

®

Cognos
®

Disclosure Management XBRL
displays the current view of an XBRL instance document for a project.

Tagging in an inline XBRL project
You can use IBM

®

Cognos
®

Disclosure Management XBRL to tag in an inline XBRL
project.

A project can be set by the administrator to be enabled for inline XBRL generation.
Some aspects of tagging are different when you work in an inline XBRL project,
particularly in a Word report object, as some tags cannot be expressed in HTML.

You must follow some tagging constraints when working with the following
structures in a document:
v paragraphs
v table cells
v list items
v sections
v pages

You cannot extend beyond a boundary in one direction without including the
boundary in the other direction. The tag cannot contain only the start or the end of
an item.

For tables, you can only tag within a cell, and for a list, within a list item. If you
cross the boundary of a cell or list item, then the tag must include the entire table
or entire list. You cannot start the tag inside a bullet list and end outside the bullet
list, or tag part of a table.

When you are creating inline XBRL tags, follow these rules:

Chapter 4. XBRL tasks 29



v Do not allow the tag to cross from one page into another.
v Do not allow the tag to cross from one section into another.
v Do not allow the tag to begin inside a list and end outside the list without

containing the whole list.
v Do not allow the tag to begin inside a table and end outside the table without

containing the whole table.
v Do not partially tag the contents of two cells in a Word object table.

If you select a transformation that is invalid for inline tagging, a warning is
displayed but you can continue to tag. The tag becomes a hidden tag in your
generated inline document.

Enabling add-ins in an Excel object for tagging
Excel add-ins that connect to another data source by using formulas to create data
must be enabled in IBM

®

Cognos
®

Disclosure Management XBRL before tagging
that data.

About this task

You might need to tag data created by resolving formulas through the use of an
Excel add-in. For example, you might use Hyperion Financial Management (HFM)
formulas as data in an Excel object. In order to tag this data, these formulas must
first be resolved by enabling the HFM Smartview Excel add-in in IBM

®

Cognos
®

Disclosure Management XBRL.

Procedure
1. Open the project that you want to work with.
2. Open and check out the Excel object you want to use for tagging.
3. Click Add-Ins Mode.

Results

You can now tag any data that is using an add-in formula.

Adding an XBRL tag to an Excel object
You can use IBM

®

Cognos
®

Disclosure Management XBRL to tag data in an Excel
object.

Before you begin

Before you can work with tags in Cognos Disclosure Management XBRL, at least
one XBRL project must be created for your report. A project is an instance
document in progress and is contributed to by Excel and Word objects in different
ways.

About this task

You can select Excel object data that is required for XBRL, and then add a tag to it
to specify that it is data that is required for XBRL. For example, if your Excel object
contains monetary data, you can tag each related item of data for XBRL.
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Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. Optional: To simplify your tagging work, you can pivot or filter the Pivot

Grid to approximate the appearance of the data in the Excel object. For
example, you can change the Pivot Grid to move columns to rows, and rows
to columns. If the Pivot Grid contains extra rows or columns that are not
visible in your Excel object, you can filter them so that they are no longer
visible in the Pivot Grid.

5. Open and check out the Excel object.
6. In the Excel object, highlight the data that you want to tag.

Tip: You can save time by adding multiple tags to a range of cells in an Excel
object, if the range is contiguous. To select multiple cells, click the first cell in
the range, and then press Shift and click the last cell in the range.

7. In the Pivot Grid, select an intersection or a range of intersections where you
want to add tags for the data that you selected in the Excel object.
a. Find the intersection where you want to add the tag. You can adjust your

view of the Pivot Grid to help locate the area. If you do not know the role
and table of the concept you want to tag, you can click Search to find it.

b. In the Pivot Grid, select one or more intersections that match the type of
data that you selected in the Excel object, for example, numeric data. If
you select a range of intersections, all intersections must be contiguous,
and they must all have the same data type. Also, the concept's time period
type must match the time period you are tagging against. If the selected
concept has a period type of Instant, you must select an intersection with
a time period of Instant. There are several ways to view information about
an intersection:
v Click Highlight Item Types. Intersections of different types are

highlighted with different colors, which are described in the Legend
pane that opens. The colors in the Legend pane represent the data types:
Monetary Item Type, Decimal Item Type, Integer Item Type, Pure Item
Type, String Item Type, Date Item Type, HTML Item Type, Fractional
Item Type, and Numeric Item Type.

v With your mouse, hover over the label for the intersection. A window
opens with information about the intersection, including the data type.

v Some intersections are not suitable for tagging. Unsuitable intersections
are shaded gray. When you hover over an unsuitable intersection, you
can see a message that explains why it is unsuitable.

8. To create the tag, complete the following steps:
a. Click Tag.
b. If the data is numeric, in the Data area, select values for Unit and Decimal

accuracy.
c. Select Negated if you want the data changed from positive to negative or

from negative to positive when you generate the instance document.
d. Select a transformation set or specify a default transformation set. For

example, if you are tagging a monetary value, you might want to scale
your value to millions.

e. The Preview area contains a view of the data as it will appear in the Pivot
Grid. If necessary, make changes in the Data area.
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f. Click OK. In the Pivot Grid, the data is visible in the intersection or
intersections that you selected.

Tip: If you want to create multiple tags at the same time, you can repeat the
previous three main steps as many times as necessary before you continue
with the following steps.

9. To view details of the tag that you added, click the Home tab, and then click
the Show Details Pane icon in the Ribbon. The Tag Inspector tab opens,
containing details of your new tag and any other tags in the Pivot Grid.

10. Click the Excel object, and click Save in the Ribbon to save your changes.
11. Check in the Excel object.
Related information:
“XBRL tagging overview” on page 23
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. When a taxonomy is available, you can use IBM

®

Cognos
®

Disclosure Management XBRL to tag items of business data to build an instance
document.
“Using negation to reverse the sign of tagged items” on page 41
You can reverse the sign of a value in IBM

®

Cognos
®

Disclosure Management XBRL
from positive to negative or from negative to positive when you generate the
instance document. For example, if your data contains a negative numeric value
(for example, for Cost of Sales), you might want to express it as a positive
number.
“IBM Cognos Disclosure Management XBRL interface” on page 9
The IBM

®

Cognos
®

Disclosure Management XBRL interface is designed to make it
easy for you to perform tasks related to XBRL. Depending on the task that you are
completing, various Ribbons and windows provide the information that you need.
“Transformations and transformation sets” on page 22
You can use transformations to tag different types of inputs from an Excel object in
IBM

®

Cognos
®

Disclosure Management XBRL.

Finding XBRL tags in an Excel object
An Excel object in IBM

®

Cognos
®

Disclosure Management XBRL might contain
many tags. You can easily find all tags in an Excel object whenever necessary.

About this task

You can use these instructions to search for all tags in any one Excel object.
However, you cannot search for all tags in multiple Excel objects at the same time.

Procedure
1. Open the project that you want to work with.
2. Open the Excel object that contains the tags that you want to find.
3. Click Highlight Tags. Each cell that contains tagged data now displays a blue

background, even if a different color was originally applied to the cell.

Restriction: During the time that the highlights appear in the Excel object, you
can continue to create tags, but you cannot edit the Excel object in any other
way.

4. When you are finished viewing tags in the Excel object. click Highlight Tags
again. The original background color of the cell returns, and you can edit the
Excel object if necessary.
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Adding an XBRL tag to a Word object
You can use IBM

®

Cognos
®

Disclosure Management XBRL to add an XBRL tag to
content in a Word object.

Before you begin

Before you can work with tags in Cognos Disclosure Management XBRL, at least
one XBRL project must be created for your report. A project is an instance
document in progress and is contributed to by Excel and Word objects in different
ways.

About this task

You can select Word object data that is required for XBRL, and then add a tag to it
to specify that it is content that is required for XBRL. For example, if your Word
object contains the name of your company, you can tag that content for XBRL.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. Optional: To simplify your tagging work, you can pivot or filter the Pivot

Grid to approximate the appearance of the data in the Word object. For
example, you can change the Pivot Grid to move columns to rows, and rows
to columns. If the Pivot Grid contains extra rows or columns that are not
visible in your Word object, you can filter them so that they are no longer
visible in the Pivot Grid.

5. Open and check out the Word object.
6. In the Word object, highlight the content that you want to tag.
7. In the Pivot Grid, select an intersection where you want to add tags for the

content that you selected in the Word object.
a. Find the intersection where you want to add the tag. You can adjust your

view of the Pivot Grid to help locate the area. If you do not know the role
and table of the concept you want to tag, you can click Search to find it.

b. Select an intersection that matches the type of data that you selected in the
Word object, for example, string data. Also, the concept's time period type
must match the time period you are tagging against. If the selected
concept has a period type of Instant, you must select an intersection with
a time period of Instant. There are several ways to view information about
an intersection:
v Click Highlight Item Types. Intersections of different types are

highlighted with different colors, which are described in the Legend
pane that opens. The colors in the Legend pane represent the data types:
Monetary Item Type, Decimal Item Type, Integer Item Type, Pure Item
Type, String Item Type, Date Item Type, HTML Item Type, Fractional
Item Type, and Numeric Item Type.

v With your mouse, hover over the intersection. A window opens with
information about the intersection, including the data type.

v Some intersections are not suitable for tagging. Unsuitable intersections
are shaded gray. When you hover over an unsuitable intersection, you
can see a message that explains why it is unsuitable.

8. To create the tag, complete the following steps:
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a. Click Tag.
b. In the Data area, if the data is numeric, select values for Unit and Decimal

accuracy.
c. Select Negated if you want the data changed from positive to negative or

from negative to positive when you generate the instance document.
d. Select a transformation set or specify a default transformation set. For

example, if you are tagging a monetary value, you might want to scale
your value to millions.

e. Click OK. Data is visible in the Pivot Grid, in the intersection that you
selected.

f. Click OK.

Tip: If you want to create multiple tags at the same time, you can repeat the
previous three main steps as many times as necessary before you continue
with the following steps.

9. To view details of the tag that you added, click the Home tab, and then click
the Show Details Pane icon in the Ribbon. The Tag Inspector tab opens,
containing details of your new tag and any other tags in the Pivot Grid.

10. Click the Word object, and click Save in the Ribbon to save your changes.
11. Check in the Word object.
Related information:
“XBRL tagging overview” on page 23
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. When a taxonomy is available, you can use IBM

®

Cognos
®

Disclosure Management XBRL to tag items of business data to build an instance
document.
“Using negation to reverse the sign of tagged items” on page 41
You can reverse the sign of a value in IBM

®

Cognos
®

Disclosure Management XBRL
from positive to negative or from negative to positive when you generate the
instance document. For example, if your data contains a negative numeric value
(for example, for Cost of Sales), you might want to express it as a positive
number.
“IBM Cognos Disclosure Management XBRL interface” on page 9
The IBM

®

Cognos
®

Disclosure Management XBRL interface is designed to make it
easy for you to perform tasks related to XBRL. Depending on the task that you are
completing, various Ribbons and windows provide the information that you need.
“Transformations and transformation sets” on page 22
You can use transformations to tag different types of inputs from an Excel object in
IBM

®

Cognos
®

Disclosure Management XBRL.

XBRL items and XBRL tags
In IBM

®

Cognos
®

Disclosure Management XBRL, you can edit XBRL items and
XBRL tags.

There is a clear distinction between an XBRL item and an XBRL tag.
v An XBRL item consists of a concept and a context. This documentation

sometimes refers to an item as an XBRL fact.
v A XBRL tag is a pointer to the location where a facts value resides and rules on

how to transform that value to be ready for submission

This documentation refers to XBRL item properties as fact properties and tag
properties as value properties.
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v Fact properties refer to the context of the XBRL item. Fact properties are units,
entities, and time periods. You can view and edit XBRL items in the Pivot Grid.

v Value properties refer to the instructions that Cognos Disclosure Management
XBRL uses to transform a value and the accuracy in which it is reporting a
value. Value properties are transformation sets, decimal accuracy, and negation.
You can view and edit XBRL tags in the Tag Inspector tab.

You cannot change the dimensional context of an XBRL item.

Editing an XBRL item in the Pivot Grid
In IBM

®

Cognos
®

Disclosure Management XBRL, you can edit XBRL items in the
Pivot Grid.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Select one or more XBRL items in the Pivot Grid.
4. Right-click the item and click Edit Item.
5. Optional: The tag that you select might contain multiple items of information;

for example, the same monetary value in both USD and CAD.
v If you want to edit both items, for example, to make both units the same,

right-click and edit both.
v If you want to edit only one of the values, right-click the item in the list and

click Edit Item.
6. In the Tag Editor window, change any of the existing properties as needed.
7. Click OK.

Restriction: If you try to edit an XBRL item or XBRL tag that someone else has
just deleted, your changes are not saved, and they are rolled back. If another
user tries to edit the same XBRL item or XBRL tag at the same time as you, the
changes of the person who saves last are the changes that are saved.

Editing an XBRL tag in the Tag Inspector tab
In IBM

®

Cognos
®

Disclosure Management XBRL, you can edit XBRL tags in the Tag
Inspector tab.

Procedure
1. Open the project that you want to work with.
2. Select one or more tags in the Tag Inspector tab.
3. Right-click the item and click Edit. The Tag Editor window opens.
4. In the Tag Editor window, change any of the existing values as needed.
5. Click OK.

Restriction: If you try to edit an XBRL item or XBRL tag that someone else has
just deleted, your changes are not saved, and they are rolled back. If another
user tries to edit the same XBRL item or XBRL tag at the same time as you, the
changes of the person who saves last are the changes that are saved.

Viewing XBRL tags in a summary report
As you work in IBM

®

Cognos
®

Disclosure Management XBRL, you can view a
summary report of all the tags in a report.

Chapter 4. XBRL tasks 35



About this task

A tagging summary report in Cognos Disclosure Management, contains all of the
tagged data in your generated report. You use the tagging summary report to
review each tag to make sure all the required data is tagged properly.

Tip: You can see only the tags that are contained in printable sections of your
report.

The summary report is a temporary HTML document that highlights each tag.
Hover over a tag to view information about that tag, including the concept name,
time period, entity scheme and identifier, and value.

Procedure
1. Open the project that you want to work with.
2. Click Show Tags in Report in the Ribbon. The All processes completed

window opens.
3. When the tagging summary report is complete, click the Open icon in the All

processes completed window. The tagging summary report opens in an HTML
browser with all tags highlighted.

Selecting content from a report object to define a footnote
Your Excel and Word objects might contain data or text that you want to use as an
XBRL footnote. You can use IBM

®

Cognos
®

Disclosure Management XBRL to select
that content to define a footnote.

Before you begin

Before you can work with tags in Cognos Disclosure Management XBRL, at least
one XBRL project must be created for your report. A project can only be associated
with one report. A project is an instance document in progress and is contributed
to by Excel and Word objects in different ways.

About this task

The content for the footnote must exist in the Excel and Word objects that you
check out. You can add the footnote only to an intersection in the Pivot Grid that
already contains a tag.

Restriction: When you add tags, you can create several tags at the same time and
then save them. However, when you add footnotes, you must save each one
individually.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. Optional: To simplify your tagging work, you can pivot or filter the Pivot

Grid to approximate the appearance of the data in the Excel object. For
example, you can change the Pivot Grid to move columns to rows, and rows
to columns. If the Pivot Grid contains extra rows or columns that are not
visible in your Excel object, you can filter them so that they are no longer
visible in the Pivot Grid.
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5. Open and check out the report object.
6. If the source of the footnote content is an Excel object, complete the following

steps:
a. In the Excel object, highlight the data that you want to use for the

footnote. You can select only one cell.
b. In the Pivot Grid, select the tagged intersection where you want to add

the footnote. You can use Search to find the appropriate location.
v If the Excel data that you selected contains ##RS or ##XS variables, the

table between that cell and the corresponding ##RE or ##XE from the
Excel object is stored as escaped HTML as the content of the footnote.
The same rules for text block tagging apply (column suppression,
superscript, and so on).

v If the Excel data that you selected does not contain ##RS or ##XS
variables, the content of the highlighted cell in the Excel object is
converted to escaped HTML and stored as the content of the footnote.

Important: Placement of the ##RS, ##RE and ##XS, ##XE variable
combinations must follow this format:
v The ##XS and ##XE combination must be within the ##RS and ##RE

combination. If an ##XS or ##XE variable is placed outside of an ##RS and
##RE combination, you get unexpected results on the output.

v The ##RS and ##XS variables must be placed in the same vertical column
and the ##XE variable must also be in the same vertical column as ##RE.

v You cannot have multiple ##RS combinations on a sheet in an Excel
object.

v You can have multiple ##XS, ##XE combinations within a ##RS and ##RE
combination, however, the ranges must not overlap.

7. If the source of the footnote content is a Word object, complete the following
steps:
a. In the Word object, highlight the content that you want to use for the

footnote.
b. In the Pivot Grid, select the tagged intersection where you want to add

the footnote.
8. Click the Home tab, click the Add Footnote icon in the Ribbon, and click

From Current. Cognos Disclosure Management XBRL creates a bookmark in
the Excel or Word object, and links the selected text to the newly created
footnote. In the Pivot Grid, the content of the footnote is displayed as a
superscript.

9. To view details of the footnote that you added, click the Home tab, and then
click the Show Details Pane icon in the Ribbon. The Tag Inspector tab opens.
Click the Footnotes tab. The Footnotes tab contains details of your new
footnote and any other footnotes in the Pivot Grid. When you click the
number in the intersection, you can navigate to the footnote. When you click
the More link in the footnote, you can see information about the footnote and
you can navigate to the source intersection in the Pivot Grid. The footnotes
that are shown in the panel are the footnotes that are related to all facts
currently displayed in the Pivot Grid.

10. Check in the report object.
Related information:
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“XBRL tagging overview” on page 23
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. When a taxonomy is available, you can use IBM

®

Cognos
®

Disclosure Management XBRL to tag items of business data to build an instance
document.
“The Pivot Grid” on page 13
A pivot grid is an area of the screen that is used to view and interact with the XBRL
instance data. The Pivot Grid in IBM

®

Cognos
®

Disclosure Management XBRL
displays the current view of an XBRL instance document for a project.
“IBM Cognos Disclosure Management XBRL interface” on page 9
The IBM

®

Cognos
®

Disclosure Management XBRL interface is designed to make it
easy for you to perform tasks related to XBRL. Depending on the task that you are
completing, various Ribbons and windows provide the information that you need.

Reusing an existing footnote
A footnote is a supporting piece of XBRL information that is tied to a fact. If a
footnote was already created from content in Excel and Word objects, you can use
IBM

®

Cognos
®

Disclosure Management XBRL to reuse an existing footnote.

Before you begin

Before you can work with tags in Cognos Disclosure Management XBRL, at least
one XBRL project must be created for your report. A project is a container that is
used to store the tags that make up an instance document.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. Optional: To simplify your tagging work, you can pivot or filter the Pivot Grid

to approximate the appearance of the data in the Excel object. For example, you
can change the Pivot Grid to move columns to rows, and rows to columns. If
the Pivot Grid contains extra rows or columns that are not visible in your Excel
object, you can filter them so that they are no longer visible in the Pivot Grid.

5. In the Pivot Grid, find the intersection where you want to add an existing
footnote. You can use Search to find the appropriate pivot view. Click From
Existing. In the Select a Footnote window, select the appropriate footnote.

Tip: To apply an existing footnote to more than one fact at the same time, you
can select a range of intersections in the Pivot Grid. However, you cannot
select a non-contiguous set of intersections.
Cognos Disclosure Management XBRL attaches the previously created footnote
to the selected fact or facts.

6. To view details of the footnote that you added, click the Home tab, and then
click the Show Details Pane icon in the Ribbon. The Tag Inspector tab opens.
Click the Footnotes tab. The Footnotes tab contains details of your new
footnote and any other footnotes in the Pivot Grid. When you click the number
in the intersection, you can navigate to the footnote. When you click the More
link in the footnote, you can see information about the footnote and you can
navigate to the source intersection in the Pivot Grid. The footnotes that are
shown in the panel are the footnotes that are related to all facts currently
displayed in the Pivot Grid.

Related information:
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“XBRL tagging overview” on page 23
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. When a taxonomy is available, you can use IBM

®

Cognos
®

Disclosure Management XBRL to tag items of business data to build an instance
document.
“The Pivot Grid” on page 13
A pivot grid is an area of the screen that is used to view and interact with the XBRL
instance data. The Pivot Grid in IBM

®

Cognos
®

Disclosure Management XBRL
displays the current view of an XBRL instance document for a project.
“IBM Cognos Disclosure Management XBRL interface” on page 9
The IBM

®

Cognos
®

Disclosure Management XBRL interface is designed to make it
easy for you to perform tasks related to XBRL. Depending on the task that you are
completing, various Ribbons and windows provide the information that you need.

Adding an XBRL text block
A text block is an assembly of one or more sections of text, which might include
escaped HTML, that is drawn from one or more reporting objects in XBRL. You
can use IBM

®

Cognos
®

Disclosure Management XBRL to create a text block from
data in Excel and Word objects.

Before you begin

Before you can work with tags in Cognos Disclosure Management XBRL, at least
one XBRL project must be created for your report. A project is an instance
document in progress and is contributed to by Excel and Word objects in different
ways.

About this task

A text block can be assembled from many parts from Excel and Word objects. You
can select any block of data in an Excel or Word object, and then add a tag to it to
specify that it is data that is required for XBRL. In an Excel object, the text block
can be a section of data, or all data in the Excel object if necessary. In a Word
object, the text block can be a sentence, a paragraph, or the entire content in the
Word object if necessary.

Restriction: When you add tags, you can create several tags at the same time, and
then save them. However, when you add text blocks, you must save each one
individually.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. Optional: To simplify your tagging work, you can pivot or filter the Pivot Grid

to approximate the appearance of the data in the Excel object. For example, you
can change the Pivot Grid to move columns to rows, and rows to columns. If
the Pivot Grid contains extra rows or columns that are not visible in your Excel
object, you can filter them so that they are no longer visible in the Pivot Grid.

5. If the source of the text block is an Excel object, complete the following steps:
a. Open and check out the Excel object.
b. In the Excel object, highlight the data that you want to tag. The text block

can be a section of data, or all data in the Excel object if necessary.
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v If you want to select all the cells and contents between ##RS and ##RE
variables, select the cell that contains the ##RS variable.

v If you want to select all the cells and contents between ##XS and ##XE
variables, and also the cells on the same rows as the ##XS and ##XE
variables, select the cell that contains the ##XS variable.

Important: Placement of the ##RS, ##RE and ##XS, ##XE variable
combinations must follow this format:
v The ##XS and ##XE combination must be within the ##RS and ##RE

combination. If an ##XS or ##XE variable is placed outside of an ##RS and
##RE combination, you get unexpected results on the output.

v The ##RS and ##XS variables must be placed in the same vertical column
and the ##XE variable must also be in the same vertical column as ##RE.

v You cannot have multiple ##RS combinations on a sheet in an Excel
object.

v You can have multiple ##XS, ##XE combinations within a ##RS and ##RE
combination, however, the ranges must not overlap.

c. In the Pivot Grid, select the intersection where you want to create the text
block for the data that you selected in the Excel object. You cannot select an
intersection that is shaded gray.

Important: You must select an intersection whose type is textblock or
escapedItem, or any type that extends any of these two. To find the type of
an intersection, hover over its header, and view the type in the window that
opens. Also, the concept's time period type must match the time period you
are tagging against. If the selected concept has a period type of Instant, you
must select an intersection with a time period of Instant.

6. If the source of the text block is a Word object, complete the following steps:
a. Open and check out the Word object.
b. In the Word object, highlight the content that you want to tag. The text

block can be a sentence, a paragraph, or the entire content in the Word
object if necessary.

c. In the Pivot Grid, select the intersection where you want to create the text
block for the data that you selected in the Word object. You cannot select an
intersection that is shaded gray.

Important: You must select an intersection whose type is textblock or
escapedItem, or any type that extends any of these two. To find the type of
an intersection, hover over its header, and view the type in the window that
opens.

7. To create the text block, complete the following steps:
a. Click Tag.
b. In the confirmation window that opens, click Yes to confirm that you want

to save the document during the creation of the text block. The Text Block
Preview window opens, showing all text blocks in the Pivot Grid.

c. Optional: By default, when you generate your instance document, the
component parts of a text block appear in the order in which they were
added to the text block. If you want a different order, click Allow Tag
Order to be Changed, and drag the component parts of the text block to the
order that you prefer.

d. Click OK. An HTML link appears in the intersection. To view the contents
of the text block that you added, click the HTML link. In the Text Block
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Preview window that opens, you can see the contents of the text block. If
the intersection contains multiple text block tags, the Text Block Preview
window contains the text blocks from all text block tags in that intersection.

8. To view more details about the text block that you added, click the User Object
Summary tab, and then click the Show Details Pane icon in the Ribbon. The
Tag Inspector tab opens, containing details of your new text block and any
other tags in the Pivot Grid. In the Value or Source Value column, click the
HTML link in the row associated with your text block tag. If the intersection
contains multiple text block tags, the Tag Inspector tab contains a separate row
for each tag.

9. Check in the Excel or Word object.
Related information:
“XBRL tagging overview” on page 23
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. When a taxonomy is available, you can use IBM

®

Cognos
®

Disclosure Management XBRL to tag items of business data to build an instance
document.
“The Pivot Grid” on page 13
A pivot grid is an area of the screen that is used to view and interact with the XBRL
instance data. The Pivot Grid in IBM

®

Cognos
®

Disclosure Management XBRL
displays the current view of an XBRL instance document for a project.
“IBM Cognos Disclosure Management XBRL interface” on page 9
The IBM

®

Cognos
®

Disclosure Management XBRL interface is designed to make it
easy for you to perform tasks related to XBRL. Depending on the task that you are
completing, various Ribbons and windows provide the information that you need.

Using negation to reverse the sign of tagged items
You can reverse the sign of a value in IBM

®

Cognos
®

Disclosure Management XBRL
from positive to negative or from negative to positive when you generate the
instance document. For example, if your data contains a negative numeric value
(for example, for Cost of Sales), you might want to express it as a positive
number.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. Open and check out the report object that contains a numeric value whose sign

you need to reverse from positive to negative, or from negative to positive.
5. Create the tag as usual. The selection in the Pivot Grid must consist of all

numeric items. If you select a single element of a dropdown, only that item is
negated. If you select multiple cells, all selected items are negated.

6. In the Tag window, select the Negated check box. In the Pivot Grid, the
number contains a negative sign if the original value in the report object was
positive, and a positive sign if the original value in the report object was
negative. Additionally, if you open the Tag Inspector tab, you can see
information related to negation in the Negated column.

7. Click the report object, and click Save in the Ribbon to save your changes. All
tags associated to the item in the Pivot Grid are negated.
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Important: If a tag already exists and the creation of a negated value conflicts
with the previous value, the Pivot Grid shows an error that multiple values are
specified for a single fact

8. Check in the report object.

Tip: If you need to apply negation to a fact after it has been tagged, you do
not need to open or check out the report object that contains the fact.
Right-click the fact in the Pivot Grid, and click Negate Items. In the Pivot
Grid, the number contains a negative sign if the original value in the Pivot
Grid was positive, and a positive sign if the original value in the Pivot Grid
was negative. Additionally, if you open the Tag Inspector tab, you can see
information related to negation in the Negated column.

Related information:
“XBRL tagging overview” on page 23
A tag is a link between an XBRL fact and its source data, such as a report object or
the result of a query. When a taxonomy is available, you can use IBM

®

Cognos
®

Disclosure Management XBRL to tag items of business data to build an instance
document.
“Adding an XBRL tag to an Excel object” on page 30
You can use IBM

®

Cognos
®

Disclosure Management XBRL to tag data in an Excel
object.
“Adding an XBRL tag to a Word object” on page 33
You can use IBM

®

Cognos
®

Disclosure Management XBRL to add an XBRL tag to
content in a Word object.

Deleting an XBRL text block or an XBRL tag from an Excel or
Word object

If you no longer need a text block or an XBRL tag from an Excel or Word object,
you can use IBM

®

Cognos
®

Disclosure Management XBRL to delete it.

Before you begin

Before you can tag items in a report in Cognos Disclosure Management XBRL, it
must be associated with at least one project. A project is an instance document in
progress and is contributed to by Excel and Word objects in different ways.

About this task

You cannot undo a deletion. Proceed with caution. The following procedure
describes how to delete tags by deleting the items with which they are associated.
Deleting an item deletes all of its tags. When deleting the last tag of an item, the
item is also deleted.

Important: The content of a text block item consists of one or more tags. You
might want to delete only one of those tags without deleting the entire text block
item. You can do this by using the Tag Inspector tab to view all tags that make up
the content of the text block item and then delete tags individually.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
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4. Optional: To simplify your tagging work, you can pivot or filter the Pivot Grid
to approximate the appearance of the data in the Excel object. For example, you
can change the Pivot Grid to move columns to rows, and rows to columns. If
the Pivot Grid contains extra rows or columns that are not visible in your Excel
object, you can filter them so that they are no longer visible in the Pivot Grid.

5. In the Pivot Grid, right-click the tag or text block, and click Delete Item.
6. In the confirmation window that opens, click Yes to delete the item.
7. If the report object associated with the tag is not checked out, a confirmation

window opens. Click Yes to check out any associated report objects, allow the
system to update them, and check them back in.

Results

The item is deleted.

Deleting an XBRL footnote
If you no longer need an XBRL footnote, you can use IBM

®

Cognos
®

Disclosure
Management XBRL to delete it.

About this task

You cannot undo a deletion. Proceed with caution.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. Optional: To simplify your tagging work, you can pivot or filter the Pivot Grid

to approximate the appearance of the data in the Excel object. For example, you
can change the Pivot Grid to move columns to rows, and rows to columns. If
the Pivot Grid contains extra rows or columns that are not visible in your Excel
object, you can filter them so that they are no longer visible in the Pivot Grid.

5. To find footnotes, click the Home tab. Then, click the Show Details Pane icon
in the Ribbon, and click the Footnotes tab.

6. Click Delete Footnote and then complete one of the following steps:
v To remove the footnote and all links with any facts, in the current Pivot Grid

or anywhere else, select one or more footnotes in the Footnotes tab and
select Delete the selected footnote and all links.

v To remove any links that the footnotes have with any facts in the current
view, select one or more footnotes in the Footnotes tab and select Unlink the
selected footnote from the current view. If there are no other links, the
footnotes are also removed.

v To remove the links between the selected footnotes and any facts within the
selection, select one or more footnotes in the Footnotes tab and one or more
linked intersections in the current Pivot Grid. Then, select Unlink the
selected footnote from the selected items. If one or more of the intersections
is a multi-fact, only the currently selected fact has its link severed. If, after
this operation, there are any footnotes that are no longer linked to any
intersections, the footnotes are also removed.
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XBRL query tags
In IBM

®

Cognos
®

Disclosure Management XBRL, you can create an XBRL tag
against a relational query where each row in the relational query result represents
an XBRL fact.

An aspect of the fact can be derived dynamically from a column in the row, or
directly from an aspect that is associated with the project. You can use an XBRL
query tag to automatically tag many facts at the same time.

Adding an XBRL query tag from a relational query
You can use an XBRL query tag that is created from a relational query in IBM

®

Cognos
®

Disclosure Management XBRL to create many facts dynamically,
depending on the number of rows in the relational query.

Before you begin

Before you can work with query tags in Cognos Disclosure Management XBRL, at
least one XBRL project must be created for your report and it must have at least
one relational query that is visible to that report. A project is a container that is
used to store the tags that make up an instance document. The project's Enable
Relational Query Tagging option must be enabled.

When you create the query in the Add Relational Query wizard, you must either
select the report associated with this project or the Make This Query Global check
box to make the query available to all reports. Otherwise, you cannot see the query
in the Report queries pane.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Pivot Grid.
3. Above the Tag Inspector tab, click Pivot Grid.
4. In the Report queries pane, double-click the query that you want to tag. The

query must be against a relational database.
5. Click Tag.
6. Complete the steps in the Query tag wizard. Depending on your scenario, you

might not see all of the following steps.
a. In the Concept step, select a concept member to create tags against.
b. In the Value column step, select the column from the query that contains

the fact values. Optionally, select a transformation, a decimal accuracy
value, or both.

c. In the Time Period Aspect step, select the time period aspect.
v If you select Direct as the type, under Time period you have a choice of

time period aspects associated with the project.
v If you select Column as the type, and if you select the Column values

are aspect names check box, under String type column you have a choice
of all columns that return string types. This means that the column
contains strings that match the name of a time period aspect in the
current project.

v If you select Column as the type, and if you do not select the Column
values are aspect names check box, then you have two choices.
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– If the concept is a duration type, you have a choice of start and end
date columns. These columns should contain date values that represent
the start and end dates respectively. If a date does not match an
existing time period aspect in the current project, an ad hoc time
period is created. Ad hoc time periods are time periods that are
automatically created on behalf of the user just for the query tag. This
allows the user to use time periods for the query tag without manually
creating all of them.

– If the concept is an instant type, you have a choice of a single date
column. This column should contain date values that represent the
instant date. If a date does not match an existing time period aspect in
the current project, an ad hoc time period will be created. Ad hoc time
periods are time periods that are automatically created on behalf of the
user just for the query tag. This allows the user to use time periods for
the query tag without manually creating all of them.

d. In the Unit step, select the unit aspect.
v If you select Direct as the type, under Unit you have a choice of all the

unit aspects in the current project.
v If you select Column as the type, under Unit column you have a choice

of all columns that return string types. This means that the column
contains strings that match the name of a unit aspect in the current
project.

e. In the Entity step, select the entity aspect.
v If you select Direct as the type, under Entity you have a choice of all the

entity aspects in the current project.
v If you select Column as the type, and if you select the Column values

are aspect names check box, under Entity column you have a choice of
all columns that return string types. This means that the column contains
strings that match the name of the entity aspect in the current project.

v If you select Column as the type, and if you do not select the Column
values are aspect names check box, under Entity column you have a
choice of all columns that return string types. This means that the column
contains strings that match the value of the entity aspect in the current
project.

f. In the Explicit dimension step, select the explicit dimension associations. For
each dimension in the Dimension Name column, select a Column or Direct
dimension in the Associations column. If you select a column, this means
that the column contains strings that match the element ID of a explicit
dimension member in the current project.

g. In the Typed dimension step, select the typed dimension associations. For
each dimension in the Dimension Name column, select a Column or Direct
dimension in the Associations column. If you select a column, the Column
values are aspect names check box is available in the Settings column. If
this check box is selected, column values must match the name of a typed
dimension member. If this check box is cleared, the column contains actual
typed dimension values. If a typed dimension value does not match an
existing typed dimension value in the current project, an ad hoc dimension
value is created. Ad hoc dimension values are typed dimension values that
are automatically created on behalf of the user just for the query tag. This
allows the user to use typed dimension values for the query tag without
manually create all of them.

7. Click Finish to create the query tag.
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Results

Query tag additions are done through a process which can be queued due to the
activity of other query tagging processes that are also running in Cognos
Disclosure Management XBRL. The All processes completed window in the status
bar displays the progress.
v If the query tag was created properly, a check mark appears in the All processes

completed window. In the confirmation message that opens, if you want to
refresh data in the Pivot Grid, click Yes.

v If the query tag was not created properly, an exclamation mark in the All
processes completed window indicates an error that stopped the query tag
creation, and the Validation Messages tab displays any errors.

After the process has successfully completed, and after you redisplay the Pivot
Grid, you can see the query tag and its facts that you added.

Refreshing XBRL query tags
You can refresh the XBRL facts create by all relational query tags in IBM

®

Cognos
®

Disclosure Management XBRL.

Before you begin

Before you can work with query tags in Cognos Disclosure Management XBRL, at
least one XBRL project must be created for your report and it must have at least
one relational query that is visible to that report. A project is a container that is
used to store the tags that make up an instance document. The project's Enable
Relational Query Tagging option must be enabled.

When you create the query in the Add Relational Query wizard, you must either
select the report associated with this project or the Make This Query Global check
box to make the query available to all reports. Otherwise, you cannot see the query
in the Report queries pane.

Procedure
1. Open the project that you want to work with.
2. In the Home tab, click Refresh XBRL.
v To fetch the latest data for all the report objects in the current project, in the

Refresh XBRL window, click Quick Refresh.
v To fetch the latest data for all the report objects in the current project and

also the data from all data sources, in the Refresh XBRL window, click Full
Refresh.

When you perform a quick or full XBRL refresh, items and facts created by the
query tag are regenerated from the data source.

3. Select the Include query items in the refresh check box. You can see this check
box only if the Enable Relational Query Tagging check box is enabled in the
project.

Tip: When you include query items in the refresh, more time is required for
the refresh to complete.

4. Click OK.
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Deleting an XBRL query tag
If you no longer need a relational query tag in IBM

®

Cognos
®

Disclosure
Management XBRL, you can delete it along with all the XBRL facts that it created.

About this task

Unlike regular content tags in XBRL, query tags can be deleted only in the Tag
Inspector. You cannot undo a deletion. Proceed with caution.

Procedure
1. Open the project that you want to work with.
2. In the Tag Inspector tab, click the Project tab.
3. Highlight the row that contains the query tag, and click Delete.

Tip: You can delete multiple query tags at one time.
4. In the confirmation window that opens, click Yes to delete the item.

Results

Query tag deletions are done through a process that can be queued due to the
activity of other query tagging processes that are also running in Cognos
Disclosure Management XBRL. The user interface does not automatically reflect the
deletion of the query tag. You will be prompted to redisplay the Pivot Grid after
the process has successfully completed.

Tuple tags
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

For example, a tuple called Director might contain simple elements called
firstname and lastname. If the name information appears in a report object in
Cognos Disclosure Management XBRL, you can link the information in the report
object to the tuple elements by creating tuple tags.

You can use Cognos Disclosure Management XBRL to add and delete tuple tags in
Excel objects, Word objects, and footnotes. You can also hide tuples so that they do
not appear in the list of tuples in your Tuple Explorer.

Adding a tuple from the taxonomy
If a particular tuple exists in your taxonomy, but you cannot see it in the user
interface in IBM

®

Cognos
®

Disclosure Management XBRL. it might be hidden. You
can use Cognos Disclosure Management XBRL to add it to the user interface.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Tuple Explorer.
3. Above the Tag Inspector tab, click Tuple Explorer.
4. In the Tuple Explorer, click the Instance Document to expand the hierarchy and

to see the tuples in your project.
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5. If you cannot see the tuple that you need, click the Instance Document node,
click Add, and then click the tuple that you want to add.

6. Depending on your taxonomy, you might be able to add additional instances of
a tuple. For example, if you have a Director tuple, and there are three directors
in your company, you might be able to add two additional instances of the
Director tuple. To create an additional instance of a tuple, right-click the
Instance Document node and select the tuple that you want to add; to add an
additional instance of a nested tuple, right-click the parent tuple. If your
taxonomy allows additional instances of the child tuple, the Add icon is
available. Click Add and then select the child tuple that you want to add.

Results

The tuple that you selected is added to the end of the list of tuples in the Tuple
Explorer.
Related information:
“Tuple tagging overview” on page 24
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

Hiding a tuple
If you do not plan to use a particular tuple, you can use IBM

®

Cognos
®

Disclosure
Management XBRL to hide it. The tuple will still exist in your taxonomy, but it will
no longer be visible in the user interface, and will therefore not appear in the
ouput instance document.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Tuple Explorer.
3. Above the Tag Inspector tab, click Tuple Explorer.
4. In the Tuple Explorer, click the Instance Document to expand the hierarchy and

to see the tuples in your project.
5. Right-click the tuple that you want to hide. You cannot hide a tuple that has a

tag attached to it.

Tip: To ensure that you select the correct tuple, hover your cursor over the
name of the tuple. You can see the element ID, its type, and other helpful
information.

6. Click Delete.

Important: A confirmation window does not appear when you click Delete.
The tuple disappears from the user interface but it still exists in your taxonomy.
If you did not mean to hide the tuple, click Add and select it from the list to
make it visible again.

Related information:
“Tuple tagging overview” on page 24
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

48 IBM Cognos Disclosure Management XBRL Version 10.2.7: User Guide



Adding a tuple tag to an Excel or Word object
You can use IBM

®

Cognos
®

Disclosure Management XBRL to add a tag to a tuple in
your taxonomy. The source of the data can be an Excel object or a Word object.

Before you begin

Before you can work with tuples in Cognos Disclosure Management XBRL, at least
one XBRL project must be created for your report. A project consists of a report
and a taxonomy, and the taxonomy associated with your project must contain
tuples.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Tuple Explorer.
3. Above the Tag Inspector tab, click Tuple Explorer.
4. In the Tuple Explorer, expand the hierarchy of the Instance Document so that

you can see the tuple groupings in your project. Continue to expand the
hierarchy to see individual tuples and their associated elements. Depending
on the structure of your taxonomy, some of your groupings might contain
nested groupings, as indicated by the plus sign icon beside the name of the
grouping. Continue to expand the hierarchy for these groupings to see nested
tuples.

Tip: If you can't find the tuple that you need, it might have been hidden. You
can add a tuple from the taxonomy so that it is visible in the Tuple Explorer
again.

5. Open and check out the Excel or Word object that contains the data that you
want to link to a tuple.

6. In the report object, highlight the data that you want to associate with a tuple
element. Make sure that the type of data that you select in the Excel or Word
object matches the type of data associated with the tuple element that you
plan to select. For example, if the tuple element type is monetary, you must
select monetary data in the Excel or Word object.

7. In the Tuple Explorer, select the element of the tuple that will be the target for
the tag.

Tip: To ensure that you select the correct tuple, hover your cursor over the
name of the tuple. You can see the element ID, its type, and other helpful
information.

8. To create the tuple tag, complete the following steps:
a. Click Tag.
b. Complete the fields in the Tuple Tag Wizard. Select a transformation set, if

necessary. For example, if you are tagging a monetary value, you might
want to scale your value to millions.

c. The Preview area contains a view of the data as it will appear. If necessary,
make changes in the Data area.

d. Click Finish. In the Tuple Explorer, the tag is visible in the selected
element.

9. In the Tag Inspector tab, beside Show all tags in the following location,
select Project, Data Area, Data Area Selection, Report Object, or Report
Object Selection. You can see details of your new tag in the location that you
selected.
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10. Click the report object, click Report Object under the Report Object Tools tab
above the Ribbon, and click Save in the Ribbon to save your changes.

11. Check in the report object.
Related information:
“Tuple tagging overview” on page 24
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

Deleting a tuple tag
If you no longer need a tuple tag, you can use IBM

®

Cognos
®

Disclosure
Management XBRL to delete it.

About this task

You cannot undo a deletion. Proceed with caution.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Tuple Explorer.
3. Above the Tag Inspector tab, click Tuple Explorer.
4. In the Tuple Explorer, expand the hierarchy of the Instance Document so that

you can see the tuple groupings in your project. Continue to expand the
hierarchy until you can see the tuple element that contains the tag that you
want to delete.

5. Optional: Open and check out the Excel or Word object that contains the source
data for the tag that you want to delete.

6. In the Tuple Explorer, right-click the tuple tag that you want to delete.

Tip: To ensure that you select the tag for the correct tuple, hover your cursor
over the name of the tuple. You can see the element ID, its type, and other
helpful information.

7. Click Delete. Alternatively, find the tuple tag in the Tag Inspector tab and then
click Delete.

8. In the confirmation window that opens, click Yes to delete the item.
9. If the report object associated with the tag is not checked out, a confirmation

window opens. Click Yes to check out any associated report objects, allow the
system to update them, and check them back in.

Related information:
“Tuple tagging overview” on page 24
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

Adding a footnote to a tuple tag
Your Excel and Word objects might contain data or text that you want to use as a
footnote to a tuple tag. You can use IBM

®

Cognos
®

Disclosure Management XBRL
to create a new footnote for a tuple tag, or to add an existing footnote to multiple
tuple tags.

50 IBM Cognos Disclosure Management XBRL Version 10.2.7: User Guide



Before you begin

Before you can work with tuples in Cognos Disclosure Management XBRL, at least
one XBRL project must be created for your report. A project consists of a report
and a taxonomy, and the taxonomy associated with your project must contain
tuples.

Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Tuple Explorer.
3. Above the Tag Inspector tab, click Tuple Explorer.
4. In the Tuple Explorer, click the Instance Document to expand the hierarchy and

see the tuples that are available in your project.
5. Find an existing tuple tag that you want to add a footnote to.
6. To create a new footnote for a tuple element, complete the following steps:

a. Open and check out the Excel or Word object that contains the source
content for the new footnote.

b. In the Excel or Word object, highlight the data that you want to use for the
footnote. In an Excel object, you must select only one cell.

c. In the Tuple Explorer, click the element that contains the tuple tag that you
want to add the footnote to. You can use Search to find the appropriate
location.

d. Click the Home tab and then click Add Footnote > From Current Object
Selection. A number appears in the tuple element, indicating the new
footnote. You can see the content of the new footnote in the Tag Inspector
tab.

7. To reuse a footnote from another location, complete the following steps:
a. In the Tuple Explorer, click the element that contains the tuple tag that you

want to add the footnote to. You can use Search to find the appropriate
location.

b. Click the Home tab and then click Add Footnote > From Existing.
c. In the list that appears, select the footnote content that you want to reuse. A

number appears in the tuple element, indicating the new footnote. You can
see the content of the new footnote in the Tag Inspector tab.

8. Click the report object, click Report Object under the Report Object Tools tab
above the Ribbon, and click Save in the Ribbon to save your changes.

9. Check in the report object.
Related information:
“Tuple tagging overview” on page 24
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

Deleting a footnote from a tuple
If you no longer need a footnote that is attached to a tuple, you can use IBM

®

Cognos
®

Disclosure Management XBRL to delete it.

About this task

You cannot undo a deletion. Proceed with caution.
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Procedure
1. Open the project that you want to work with.
2. In the Data Tools area above the Ribbon, click Tuple Explorer.
3. Above the Tag Inspector tab, click Tuple Explorer.
4. In the Tuple Explorer, click the Instance Document to expand the hierarchy and

see the tuples that are available in your project.
5. Find the tuple tag that contains the footnote that you want to delete.
6. Click Delete Footnote and then complete one of the following steps:
v To remove the footnote and all links with any facts, in the Tuple Explorer or

anywhere else, select one or more footnotes in the Footnotes tab and select
Delete the selected footnote and all links.

v To remove any links that the footnotes have with any facts in the current
view, select one or more footnotes in theFootnotes tab and select Unlink the
selected footnote from the current view. If there are no other links, the
footnotes are also removed.

v To remove the links between the selected footnotes and any facts within the
selection, select one or more footnotes in theFootnotes tab. Then, select
Unlink the selected footnote from the selected items. If, after this operation,
there are any footnotes that are no longer linked to any facts in the Tuple
Explorer or anywhere else, the footnotes are also removed.

Related information:
“Tuple tagging overview” on page 24
A tuple is an XML structure that is used to group concepts in an XBRL taxonomy
that must be understood together. When a taxonomy that contains tuples is used
with your project, you can use IBM

®

Cognos
®

Disclosure Management XBRL to link
information in your Excel or Word object to tuples in your taxonomy.

Orphan tags
A tag or footnote in IBM

®

Cognos
®

Disclosure Management XBRL is associated
with a data source, which can be a report object. An orphan tag is an XBRL tag that
has become disassociated from its data source.

An orphan tag or footnote remains in the database, even if the range, bookmark, or
query that identifies the data source, no longer exists. The tag or footnote no
longer has a data source from which its data can be updated or refreshed. Orphan
tags get generated in the instance document.

An orphan tag can occur in the following situations:
v A user deletes a report object that contains a tag or footnote. The named range

or bookmark that the tag refers to as its data source is also deleted.
v A user deletes a column or row that contains a tag. The named range that a tag

refers to as its data source is also deleted.
v In a Word object, a user deletes a bookmark that was used by a tag. The

bookmark that the tag refers to as its data source is also deleted.
v A user checks out a report object, and does not check it back in. An

administrative user forces the report object to be checked in. If the report object
contains any changes that were created by the original user, those changes are
lost. The named range or bookmark that was used to identify its data source is
lost.

v A user creates a tag in an Excel object or Word object, but he or she does not
save the report object. For a short period of time, the named range or bookmark
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is associated with the tag in the database, but the report object has not been
saved to the database, so the database copy does not contain the bookmark or
named range. During this time, Cognos Disclosure Management XBRL creates a
temporary orphan tag. If the user discards or loses the changes in the report
object, the temporary orphan tag becomes a permanent orphan tag.
– During the time that a temporary orphan tag exists, you can see it in the Tag

Inspector tab, but when the Tag Inspector tab is filtered for tags in the
current object or object selection, it does not show the tag. If an object is
checked out, a warning is given that the tag might be orphaned.

– If a report object contains tags that were created after the object was last
modified, and the object is checked out to a user, the orphan tag is a
temporary orphan tag. If the user who created the tags saves the document,
those tags are no longer orphan tags.

– If a report object contains tags that were created after the object was last
modified, and the object is not checked out to a user, the orphan tag is a
permanent orphan tag. You cannot re-associate a permanent orphan tag to its
data source, and it should be deleted.

Restriction: This situation is not applicable for footnotes or text block tags,
because they are automatically saved when they are created.

If you generate a project that contains orphan tags, you create an XBRL item in the
instance document with the last known value that is associated with the tag.

Finding orphan tags
If a tag or footnote in IBM

®

Cognos
®

Disclosure Management XBRL is accidentally
disassociated from its data source, it is called an orphan tag. You can search your
report to find orphan tags.

About this task

An orphan tag or footnote remains in the database, even if the data source, or the
range, bookmark, or query that identifies the data source, no longer exists. The tag
or footnote no longer has a data source from which its data can be updated or
refreshed.
v If a user creates a tag in an Excel object or Word object, but the report object is

not saved, for a short period of time, then the named range or bookmark is
associated with the tag in the database. However, the report object has not been
saved to the database, so the database copy does not contain the bookmark or
named range. During this time, Cognos Disclosure Management XBRL creates a
temporary orphan tag. If the user who created the tags saves the report object,
those tags are no longer orphan tags.

v If the changes in the report object are discarded or lost, the temporary orphan
tag becomes a permanent orphan tag. You cannot re-associate a permanent
orphan tag to its data source.

You can find orphan tags in your report in any of the following ways.

Procedure
v Open the Tag Inspector tab and select the filter option to show all the tags in

the current project.
– If a report object no longer exists, you can see the orphan tag in the Tag

Inspector tab. The report name field is blank. If you try to navigate to the
report object, you receive an error message.
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– If a report object exists but a named range or bookmark has been deleted, you
can see the orphan tag in the Tag Inspector tab. The report name field looks
like a normal XBRL tag in Cognos Disclosure Management XBRL. You can
successfully navigate to the report object, but the orphan tag is not
highlighted in the report object.

v If you are viewing the Tag Inspector tab, you can group XBRL tags by report
name. You can then view all orphan tags together.

v In the Ribbon, click Show Orphan Tags.
– Temporary orphan tags are shown as warnings in the Validation Errors tab.
– Permanent orphan tags are shown as errors in the Validation Errors tab.

v Refresh or validate your project. If the report contains permanent orphan tags
that are a result of a deleted report object, a deleted named range, a deleted
bookmark, or a deleted query, you can see the orphan tags in the Validation
Errors pane. They are shown as errors.

Deleting orphan tags
If a tag or footnote in IBM

®

Cognos
®

Disclosure Management XBRL is accidentally
disassociated from its data source, it becomes an orphan tag. You should delete
orphan tags because they might present incorrect data when you generate your
instance document.

About this task

If you generate a project that contains orphan tags, you create an XBRL item in the
instance document with the last known value that is associated with the tag. You
should delete orphan tags to ensure that you always have the most current data in
your instance document.

You cannot undo a deletion. Proceed with caution.

You can delete orphan tags in your report in any of the following ways.

Procedure
v Open the Tag Inspector tab and click Delete.
v Click Refresh. The Validation Errors pane opens. Click Delete and respond to

confirmation messages. Any attached footnotes are unlinked from the tag, and
footnotes that become orphans as a result of the unlinking are also deleted.

v Click Show Orphan Tags. The Validation Errors pane opens. Click Delete and
respond to confirmation messages. Any attached footnotes are unlinked from the
tag, and footnotes that become orphans as a result of the unlinking are also
deleted.

XBRL content refresh
As you work in IBM

®

Cognos
®

Disclosure Management XBRL, you can refresh your
content from time to time, to ensure that you are working with the most recent
data.

You can refresh your data at any time while you are working. You should also
refresh your data as part of the validation and generation processes.

You can refresh the data in your report in the following ways.
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Quick Refresh
The data in the report objects is updated from the cache. The XBRL data is
also updated from the cache.

Full Refresh
The data in the report objects is updated from the data source. The XBRL
data is also updated with the most recent content.

Refreshing XBRL content
As you work in IBM

®

Cognos
®

Disclosure Management XBRL, you can refresh your
content from time to time, to ensure that you are working with the most recent
data.

Procedure
1. Open the project that you want to work with.
2. When you are viewing your data, click the Home tab.
3. Complete one of the following steps:
v To refresh data from the cache, click Refresh XBRL > Quick Refresh.
v To refresh data from the data source, click Refresh XBRL > Full Refresh.

4. If the project supports relational query tagging, and if you want to include
query items in the refresh, select the Include query items in the refresh check
box. If the queries used in query tagging return large amounts of data, this
process might take a long time.

Tip: If the project does not support relational query tagging, this check box is
not visible.

5. Click OK.
6. When the refresh is complete, click Yes in the confirmation message.

XBRL content validation
An instance document is an XML file that contains facts as defined by a taxonomy.
Instance documents contain business reporting data with associated values and
contexts. You can validate your instance document before generating it in IBM

®

Cognos
®

Disclosure Management XBRL.

You can validate your data at any time while you are working. You should also
validate your data as part of the generation processes.

You can validate the data in your report in the following ways.

XBRL validation

You can do certain validations of a report at any time. Periodic validations ensure
that errors that can cause instance document generation to fail and create filing
errors are minimized. The following kinds of validations are available:

XBRL 2.1 & Dimensional
Includes both the dimensional validation for both current taxonomy and
instance document. Also validates the calculations in the taxonomy. Any
errors that are encountered during this validation cause the generation to
fail.
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XSD Content Model
Applies the content model of an element as defined in the schema to the
value of the content of that element in an instance document.

CDM/Internal
Checks the data in the report against the data source to determine whether
the data requires updating.

EDGAR Filer Manual (EFM)
Validates that the taxonomy and instance document comply with the rules
in the current EDGAR Filer Manual.

Formula Linkbase Validation
Validates the instance document against the formula specifications in the
selected formula linkbase.

Inline XBRL validation

When the project has been set as an inline XBRL project, as well as including the
standard XBRL validation set, two further validations are available:

Generic Inline
Validates the inline XBRL document against the Inline XBRL 1.0
specification.

HM Revenue & Customs (HMRC) Validation
When the jurisdiction is set for HMRC, Style Guide v2.0, this validates the
inline XBRL document against HMRC Style Guide v2.0.

Irish Tax and Customs Validation
When the jurisdiction is set for Irish Tax and Customs, Style Guide v1.1,
this validates the inline XBRL document against Irish Tax and Customs
Style Guide v1.1.

Validating XBRL content
The Pivot Grid in IBM

®

Cognos
®

Disclosure Management XBRL identifies any fact
data that contains tags with conflicting content. If you find conflicts, you must
resolve the errors.

About this task

By validating your content frequently in Cognos Disclosure Management you can
detect and correct problems as they occur. Detecting problems early makes fixing
the errors easier and can help prevent further errors.

You must resolve any fact data that contains tags with conflicting content, such as
differing monetary values. In the Pivot Grid, facts that contain conflicting tag
content are highlighted in red. Hover over the intersection to view a warning
message. You can remove all tags that are associated with a fact by selecting the
fact and clicking Delete Items. Or, you can review and correct tagging associations
from the Tag Inspector tab.

Procedure
1. Open the project that you want to work with.
2. When you are viewing your data, click the Home tab.

Tip: You can view all tags in the project by using the Tag Inspector tab
without the Pivot Grid open by selecting Project in the Tag Inspector tab.
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Also, you use the Tag Inspector tab to view the tags in a specific report by
opening the report and selecting Report Object in the Tag Inspector tab.

3. In the Home tab, click Validate.
4. Select an option to refresh the data in the report that is associated with the

current project:

Quick Refresh
The data in the report objects is updated from the cache. The XBRL
data is also updated from the cache.

Full Refresh
The data in the report objects is updated from the data source. The
XBRL data is also updated with the most recent content.

Include query items in the refresh
If the project supports relational query tagging, and if you want to
include query items in the refresh, select this check box. If the queries
used in query tagging return large amounts of data, this process might
take a long time.

Tip: If the project does not support relational query tagging, this check box is
not visible.

5. Complete one or more of the following validation options:

XBRL 2.1 & Dimensional
To validate the current taxonomy and instance document against the
XBRL 2.1 and XBRL Dimension 1.0 specification, including calculation
links.

XSD Content Model
To validate that the values of the facts in the current instance
document match the content model of their respective elements as
defined in the governing schema.

CDM/Internal
To validate data currently available to the user against the data stored
in the internal system. If any inconsistencies are found, a refresh
occurs and the appropriate notification messages are sent.

Formula Linkbase
This validation checks that the taxonomy or instance document data
complies with rules defined in formula linkbases. When you select
Formula Linkbase validation, you must make an additional choice.
v Click Detect Formula Linkbases to search for formula linkbases

that are discoverable in the taxonomy that is associated with the
project.

v Select specific formula linkbases that were explicitly added to the
system by your administrator.

6. Click OK. The data is validated.
7. If the validation identifies conflicts, select the facts in the Pivot Grid that

contain conflicts.
8. In the Tag Inspector tab, click Selected Facts to filter your tag results.
9. Review the tags and select the tags to delete.

10. Click Delete.
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Validating inline XBRL content
As you work in IBM

®

Cognos
®

Disclosure Management XBRL you can validate
inline XBRL to determine whether any errors are present.

Before you begin

The project must be set for the generation of inline XBRL. See the IBM Cognos
Disclosure Management XBRL Administration Guide.

About this task

By validating your content frequently in Cognos Disclosure Management you can
detect and correct problems as they occur. Detecting problems early makes fixing
the errors easier and can help prevent further errors.

Procedure
1. Open the project that you want to work with.
2. Click Validate in the Ribbon. The Validation window opens.
3. From the Select Jurisdiction field, select the jurisdiction.

Important: The jurisdiction setting that you select changes the options that are
available in the Validation window and the type of validation that occurs.

4. Select an option to refresh the data in the report that is associated with the
current project:

Quick Refresh
The data in the report objects is updated from the cache. The XBRL
data is also updated from the cache.

Full Refresh
The data in the report objects is updated from the data source. The
XBRL data is also updated with the most recent content.

Include query items in the refresh
If you want to include query items, select this check box.

5. Select one or more of the following validations:

XBRL 2.1 & Dimensional
To validate against the XBRL 2.1 and XBRL Dimensions 1.0
specifications.

Important: If you select this validation, the XSD Content Model
validation is automatically selected and must be run.

XSD Content Model
To validate that the data in an element is of the correct type, as
defined by the taxonomy.

Generic Inline
Validates the inline XBRL document against the Inline XBRL 1.0
specification.

HM Revenue & Customs (HMRC) Validation
When the jurisdiction is set for HMRC Style Guide v2.0, this validates
the inline XBRL document against HMRC Style Guide v2.0.

a. When you select HM Revenue & Customs (HMRC) Validation, select the
Entity Type Identifier, Accounts End Date and Industry Sector.
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b. In the SureFile Authentication section, type your username and password
credentials to connect to HMRC services, and click Test Connection to
verify the connection.

6. Click OK. The Validation Messages tab displays any conflicts.
7. If the validation identifies conflicts, select the facts in the Pivot Grid that

contain conflicts.
8. In the Tag Inspector tab, click Selected Facts to filter your tag results.
9. Review the tags and select the tags to delete.

10. Click Delete.

Validating tuple tag content
The tuples tag in IBM

®

Cognos
®

Disclosure Management XBRL identifies any tuple
data that contains tags with conflicting content. If you find conflicts, you must
resolve the errors.

About this task

A tuple can be created invalid or be modified into an invalid state. For this reason
it is necessary for the Tuple Explorer to provide invalid indicators for invalid
tuples or tuple components. Being invalid does not prevent the tuple from being
saved. However invalid tuples will cause the instance generation to fail. Some
ways to make a tuple invalid are not permitted in the user interface, but there are
cases where the user interface does allow the modification. For example, if a tuple
has one item you can delete that item making the tuple invalid.

Procedure
1. Open the project that you want to work with.
2. Check out the report object that you want to work with.
3. In the Data Tools area above the Ribbon, click Tuple Explorer.
4. Above the Tag Inspector tab, click Tuple Explorer.
5. Click and expand the Instance Document in the pane. The Tuple Explorer

expands to show all tags. Invalid tuples show with a red indicator with the
explanation of the error.

6. Select the tuple in the Tuple Explorer that contain conflicts and resolve the
invalid tuple according to the validation error.

7. If you do not save your work, the changes that you make will be lost when
you close the workspace. An asterisk in the tag indicates that changes need to
be saved.

8. Click Save and check in the report object.

XBRL instance document generation
An instance document is an XML file that contains facts as defined by a taxonomy.
Instance documents contain business reporting data with associated values and
contexts. You must generate the instance document for your project in IBM

®

Cognos
®

Disclosure Management XBRL before you submit it to your regulatory
body.

You can generate your data at any time while you are working. The generation
process also includes refreshing and validating your data.

You can generate the data in your report in the following ways.
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XBRL generation

You can generate the XBRL report and instance document at any time as you work
with reports. XBRL report generation produces the final XBRL output and instance
document that are required for filing with your regulatory body.

You can generate your XBRL instance document when you are finished tagging or
at any time as you work.

Inline XBRL generation

When the project has been set as an inline XBRL project, you can generate the
inline XBRL report and instance document at any time as you work with reports.
Inline XBRL report generation produces the final inline XBRL output and instance
document that are required for filing with your regulatory body. The generation
also creates the needed linkbases and label file.

You can generate your inline XBRL instance document when you are finished
tagging or at any time as you work.

Generating an instance document
As you work in IBM

®

Cognos
®

Disclosure Management XBRL, you can generate an
XBRL instance document at any time.

About this task

After you complete all your report objects and tagged all the necessary data in
Cognos Disclosure Management, you generate the final XBRL output and instance
document that are required for filing with your regulatory body.

At any time, you can generate your XBRL instance document, where you can
review the XBRL code output.

Procedure
1. Open the project that you want to work with.
2. Click Generate Instance Document in the Ribbon. The Generate window

opens.
3. Select an option to refresh the data in the report that is associated with the

current project.

Quick Refresh
The data in the report objects is updated from the cache. The XBRL
data is also updated from the cache.

Full Refresh
The data in the report objects is updated from the data source. The
XBRL data is also updated with the most recent content.

4. If the project supports relational query tagging, and if you want to include
query items in the instance document, select the Generate query items check
box. If the queries used in query tagging return large amounts of data, this
process might take a long time.

Tip: If the project does not support relational query tagging, this check box is
not visible.

5. Select one or more of the following validations:
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XBRL 2.1 & Dimensional
To validate against the XBRL 2.1 and XBRL Dimensions 1.0
specifications.

Important: If you select this validation, the XSD Content Model
validation is automatically selected and must be run.

XSD Content Model
To validate that the data in an element is of the correct type, as defined
by the taxonomy.

CDM/Internal
This validation checks the data in the report objects against the data in
the database. This validation is always run.

EDGAR Filer Manual
This validation checks that the taxonomy or instance document data
complies with the current EDGAR Filer Manual.

Formula Linkbase
This validation checks that the taxonomy or instance document data
complies with rules defined in formula linkbases. When you select
Formula Linkbase validation, you must make an additional choice.
v Click Detect Formula Linkbases to search for formula linkbases that

are discoverable in the taxonomy that is associated with the project.
v Select specific formula linkbases that were explicitly added to the

system by your administrator.
6. Click OK to start the generation.

Tip: You can view the progress in the All processes completed window in the
status bar. While processes are running, the title bar shows the number of
running processes. When the processes are finished, the title is All processes
completed.

7. To open the file, open the All processes completed window in the status bar,
and click the Open icon. A check mark indicates that a process generated
properly. An exclamation point indicates an error that stopped the process.

8. To save the generated report, click the Save icon in the All processes completed
window in the status bar and browse to a new location.

Generating an instance document for inline XBRL
As you work in IBM

®

Cognos
®

Disclosure Management XBRL, you can generate an
inline XBRL and an instance document at any time.

Before you begin

The project must be enabled by the administrator for the generation of inline
XBRL. See the IBM Cognos Disclosure Management XBRL Administration Guide.

About this task

After you complete all your report objects and tagged all the necessary data in
Cognos Disclosure Management, you generate the final XBRL output and instance
document that are required for filing with your regulatory body.

At any time, you can generate your inline XBRL and instance document, where
you can review the inline XBRL code output.
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The administrator can set a project as enabled for inline XBRL generation. Inline
XBRL generation embeds XBRL instance data and metadata (using XML elements)
into an HTML or XHTML document. This allows you to see a visual representation
of the XBRL instance document while also allowing for the necessary information
in it to be extracted upon submission. When a project is specified as an inline
XBRL project, you are presented with different views and options than when you
generate just an instance document from a non-inline XBRL project:
v The Generate Instance Document button on the project's Home tab ribbon is

replaced with a Generate Inline XBRL button.
v In the Generate window, you can perform the following tasks:

– Specify the inline jurisdiction that affects how the output is validated and
generated

– Choose to highlight the tags in the output, along with a tooltip when the tags
are in the print area of the report, and the tag is not in a hidden section of the
inline XBRL.

– Generate an instance document as well as inline XBRL.
– Show hidden element comments. Comments can be inserted next to hidden

elements to describe why the elements are hidden. The comment is inert and
does not affect the viewing or processing of the inline XBRL.

– Split the document according to a boundary that you specify. The boundary
size comes from the field that defines the size of the split boundary.

Each time that you generate an inline XBRL project, it is compiled and output to a
.zip archive file. The inline XBRL document (XHTML) is contained in the .zip
archive file along with any associated image files. If you select the option to
generate an instance document, the .zip archive file will also contain the instance
document and possibly the schema that it references, depending on the type of
reference files that the project uses.

Procedure
1. Open the project that you want to work with.
2. Click Generate Inline XBRL in the Ribbon. The Generate Inline XBRL window

opens.
3. From the Select Jurisdiction field, select the jurisdiction.

Important: The jurisdiction setting that you select changes the options that are
available in the Generate Inline XBRL window and the type of validation that
occurs.

4. Select an option for generation:

Highlight Tags
Shows all tags. You can choose the tags to be highlighted in yellow in
the output, along with a tool tip when the tags are in the print area of
the report, and the tag is not in a hidden section of the inline XBRL.

Generate Instance Document
Generate an instance document as well as the inline XBRL.

Show Hidden Element Comments
Shows hidden comments. Comments can be inserted next to hidden
elements to describe why the elements are hidden. These comments are
embedded into the HTML as an XML comment. The comment is inert
and does not affect the viewing or processing of the inline XBRL.
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Allow Document Splitting
Split the document at an arbitrary boundary. The boundary is by size,
(MB = size) and comes from the Split Boundary field.

Restriction: If you have selected Irish Tax and Customs, Style Guide v.1.1 as
the Jurisdiction, then document splitting is not available.

5. Select an option to refresh the data in the report that is associated with the
current project.

Quick Refresh
The data in the report objects is updated from the cache. The XBRL
data is also updated from the cache.

Full Refresh
The data in the report objects is updated from the data source. The
XBRL data is also updated with the most recent content.

Include query items in the refresh
If the project supports relational query tagging, and if you want to
include query items in the refresh, select the Include query items in
the refresh check box. If the queries used in query tagging return large
amounts of data, this process might take a long time.

6. Select one or more of the following validations:

XBRL 2.1 & Dimensional
To validate against the XBRL 2.1 and XBRL Dimensions 1.0
specifications.

Important: If you select this validation, the XSD Content Model
validation is automatically selected and must be run.

XSD Content Model
To validate that the data in an element is of the correct type, as defined
by the taxonomy.

CDM/Internal
This validation checks the data in the report objects against the data in
the database. This validation is always run.

Formula Linkbase
This validation checks that the taxonomy or instance document data
complies with rules defined in formula linkbases. When you select
Formula Linkbase validation, you must make an additional choice.
v Click Detect Formula Linkbases to search for formula linkbases that

are discoverable in the taxonomy that is associated with the project.
v Select specific formula linkbases that were explicitly added to the

system by your administrator.

Generic Inline
Validates the inline XBRL document against the Inline XBRL 1.0
specification.

HM Revenue & Customs (HMRC) Validation
When the jurisdiction is set for HMRC Style Guide v2.0, this validates
the inline XBRL document against HMRC Style Guide v2.0.

a. When you select HM Revenue & Customs (HMRC) Validation, select the
Entity Type Identifier, Accounts End Date and Industry Sector.
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b. In the SureFile Authentication section, type your username and password
credentials to connect to HMRC services, and click Test Connection to
verify the connection.

7. Click OK to start the generation.

Tip: You can view the progress in the All processes completed window in the
status bar. While processes are running, the title bar shows the number of
running processes. When the processes are finished, the title is All processes
completed.

8. To open the file, open the All processes completed window, and click the Open
icon. A check mark indicates that a process generated properly. An exclamation
point indicates an error that stopped the process.

9. To save the generated report, click the Save icon in the All processes completed
window and browse to a new location.

Previewing SEC reports
As you work in IBM

®

Cognos
®

Disclosure Management XBRL you can preview
how your XBRL submission looks in the SEC Previewer.

About this task

The Render in SEC Previewer command in Cognos Disclosure Management uses
the same HTML rendering engine as the SEC uses at their submission preview site.

Procedure
1. Open the project that you want to work with.
2. Click Render in SEC Previewer in the Ribbon.

Tip: You can view the progress in the All processes completed window in the
status bar. While processes are running, the title bar shows the number of
running processes. When the processes are finished, the title is All processes
completed.

3. To open the file, open the All processes completed window in the status bar,
and click the Open icon. A check mark indicates that the preview rendered
properly. An exclamation point indicates that an error stopped the preview.
Click any element to view information about that element, including element
prefix and name, data type, balance type, definition, and reference information

View XBRL logs
You can use IBM

®

Cognos
®

Disclosure Management XBRL to view XBRL logs
containing a list of facts that have been deleted as a result of extension taxonomy
generation or manual taxonomy replacement in a project.

An XBRL log is created when:
v an extension taxonomy with changes that could delete facts in a project is

generated to XBRL
v the manual replacement of a taxonomy causes facts in the current project to be

deleted.

Viewing XBRL logs
In IBM

®

Cognos
®

Disclosure Management, you can open and view the contents of
an XBRL log.
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About this task

Users with the appropriate permissions can do this task.

Procedure
1. While working in a project, click the Home tab.
2. Click the View XBRL Logs icon in the Ribbon.
3. The View XBRL Logs window opens displaying a list of XBRL logs.
4. Click on a log to select it and then click View. The Messages window opens

displaying the contents of the log.
5. When you are finished reviewing the log, click OK to return to the View XBRL

Logs window.

Adding comments to XBRL logs
In IBM

®

Cognos
®

Disclosure Management, you can add comments to an XBRL log.

About this task

Users with the appropriate permissions can do this task.

Procedure
1. While working in a project, click the Home tab.
2. Click the View XBRL Logs icon in the Ribbon.
3. The View XBRL Logs window opens displaying a list of XBRL logs.
4. Click on a log to select it and then click Edit. The Edit comment in XBRL Log

window opens.
5. Enter a comment in the Comment field or modify the existing comment.
6. Click OK to return to the View XBRL Logs window.
7. Click Refresh. The comment is displayed in the Comment column.
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Appendix A. Accessibility features

IBM Cognos Disclosure Management has accessibility features that help users who
have a physical disability to use the product.

Keyboard shortcuts
IBM Cognos Disclosure Management includes keyboard shortcuts to help you
navigate the product and perform tasks.

The following keyboard shortcuts are based on U.S. standard keyboards.

Table 5. General keyboard shortcuts

Applies to Action Shortcut keys

General Perform the command for an active command
button.

Enter

General Move forward to the next item in the tab
index order. Cycle to the first tab index when
at the end.

Tab

General Move backward to the previous item in the
tab index order. Cycle to the last tab index
when at the beginning.

Shift+Tab

Check boxes Select or clear the checkbox. Spacebar

Menus Navigate down a menu and select a menu
item.

Down arrow and then
Enter

Menus Navigate up a menu and select a menu item. Up arrow and then Enter

Scrolling Scroll down. Down arrow

Scrolling Scroll up. Up arrow

Zooming Zooming in. Ctrl and +, or
Ctrl+Mouse wheel up

Zooming Zooming out. Ctrl and -, or Ctrl+Mouse
wheel down

Zooming Return to default zoom level. Ctrl+0

Navigation Reload the current page. F5

Navigation Move backward to the previously opened
page.

Alt+Left Arrow,
Backspace

Navigation Move forward to the previously opened page. Alt+Right Arrow,
Shift+Backspace

Navigation Stop a page from loading. Escape

Search Open a search box to perform a search on the
current page.

Ctrl+F, F3

Search Find the next match of the searched text on
the current page.

Ctrl+G, F3

Search Find the previous match of the searched text
on the page.

Ctrl+Shift+G, Shift+F3
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IBM and accessibility
See the IBM Accessibility Center for more information about the commitment that
IBM has to accessibility.

The IBM Accessibility Center (http://www.ibm.com/able) is available online.
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Appendix B. Multiple versions of Microsoft Office

Your reports in IBM
®

Cognos
®

Disclosure Management can contain Excel, Word,
and PowerPoint objects. Some aspects of your reports and report objects depend
on the version of Microsoft Office that was used to create the report object, and the
version of Microsoft Office that you use to open the report.

The following list shows the versions of Microsoft Office that you and other users
of your report might use to create Excel, Word, and PowerPoint objects:
v Microsoft Office 2003
v Microsoft Office 2003 with the Microsoft Office Compatibility Pack for Word,

Excel, and PowerPoint
v Microsoft Office 2007
v Microsoft Office 2010

Your reports can contain Excel, Word, and PowerPoint objects. The extension of the
file name depends on the version of Microsoft Office that was used to create the
report object.

Table 6. Extensions for report objects in Microsoft Office 2003, 2007, and 2010

Report object type
Extension in Microsoft
Office 2003

Extension in Microsoft
Office 2007 and 2010

Excel object .xls .xlsx

Word object .doc .docx

PowerPoint object .ppt .pptx

Extensions for Microsoft Office 2003, Microsoft Office 2007, and Microsoft Office
2010 are supported wherever the extension for Microsoft Office 2007 and Microsoft
Office 2010 is the same.

Restriction: Macros applied to report objects are not preserved when you save the
report object.

If all report objects in your report are created with the same version of Microsoft
Office, and all users of your report use the same version of Microsoft Office, you
do not need to read the rest of the topics in this section.

However, if any report objects in your report are created with different versions of
Microsoft Office, or some users use a different version of Microsoft Office, read the
following sections for useful tips on how to work with your report and report
objects.

Effect of multiple versions of Microsoft Office if you use Microsoft
Office 2003

If you use Microsoft Office 2003, some aspects of your reports in IBM
®

Cognos
®

Disclosure Management depend on the version of Microsoft Office that was used
to create various report objects. The version of Microsoft Office that you use can
affect actions such as opening reports and report objects, exporting report objects,
and generating reports.
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Important: You can use the Compatibility Pack for Word, Excel, and PowerPoint.
The compatibility pack upgrades the functionality of Microsoft Office 2003 so that
it works more smoothly with later versions of Microsoft Office. You can download
the compatibility pack from the Microsoft website.

Opening reports and report objects

If you use Microsoft Office 2003, consult the following table to learn about how
different Microsoft Office versions affect opening reports and report objects.

Table 7. Effect of multiple Microsoft Office versions on opening reports and report objects

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in
Microsoft Office 2003 only

You can open the report and
all report objects normally.

You can open the report and
all report objects normally.

If the report contains report
objects that were created in a
later version of Microsoft
Office

You cannot open the report
or view report objects.

To open the report, you must
install the compatibility pack,
or upgrade to the version of
Microsoft Office that was
used to create the report
object.

You can open the report and
all report objects. You view
later report objects in
Microsoft Office 2003 format,
but no changes are made in
the database.

When you save a later report
object, you automatically
save it in Microsoft Office
2003 format, and you might
lose features or formatting
specific to the later version.

To view or save the report
object in its original format,
you must upgrade to the
version of Microsoft Office
that was used to create the
report object.

Important: You might open a report in Microsoft Office 2003, and then, while the
report is open, someone might create a report object for the same report in a later
version of Microsoft Office. In this situation, you can still view the report while it
is open, but you cannot view the new report object. If you close the report, you
cannot open it again.

Copying and pasting report objects

If you use Microsoft Office 2003, consult the following table to learn about how
different Microsoft Office versions affect copying and pasting report objects.
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Table 8. Effect of multiple Microsoft Office versions on copying and pasting report objects

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in
Microsoft Office 2003 only

You can copy and paste a
report object normally by
right-clicking the report
object and then using the
Copy and Paste options.

You can copy and paste a
report object normally by
right-clicking the report
object and then using the
Copy and Paste options.

If the report contains report
objects that were created in a
later version of Microsoft
Office

You can copy and paste
report objects if you do not
open the object. The pasted
report object is retrieved
from the last saved state to
the database.

To copy and paste report
objects, you must install the
compatibility pack, or
upgrade to the version of
Microsoft Office that was
used to create the report
object.

You can copy and paste a
report object by right-clicking
the report object and then
using theCopy and Paste
options. You automatically
save the pasted report object
in Microsoft Office 2003
format, and you might lose
features or formatting
specific to the later version.

To save the pasted report
object in its original format,
you must upgrade to the
version of Microsoft Office
that was used to create the
report object.

Working with shared objects

If you use Microsoft Office 2003, consult the following table to learn about how
different Microsoft Office versions affect shared objects.

Table 9. Effect of multiple Microsoft Office versions on shared objects

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in
Microsoft Office 2003 only

You can work with shared
objects normally.

You can work with shared
objects normally.
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Table 9. Effect of multiple Microsoft Office versions on shared objects (continued)

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in a
later version of Microsoft
Office

You cannot work with shared
objects.

To work with shared objects,
you must install the
compatibility pack, or
upgrade to the version of
Microsoft Office that was
used to create the shared
object.

Report objects are opened in
Microsoft Office 2003 format.
When you try to save the
report object, you receive a
message in which you must
specify whether you want to
save in Microsoft Office 2003
format.

Reference
The content cannot
be modified. A
linked object
actually has no
content, so when an
object is opened, the
content is retrieved
from the original
source object. This
content opens in the
version of Microsoft
Office that is on
your computer, and
you might lose
features or
formatting specific
to the later version.

Copy The content can be
modified because a
copy is treated like
any other report
object that has
content. All later
shared report objects
are saved in the
version of Microsoft
Office that you use,
and you might lose
features or
formatting specific
to the later version.

To view and save the shared
object in its original format,
you must upgrade to the
version of Microsoft Office
that was used to create the
report object.

Exporting Excel objects

If you use Microsoft Office 2003, consult the following table to learn about how
different Microsoft Office versions affect Excel object exports.
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Table 10. Effect of multiple Microsoft Office versions on exporting Excel objects

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in
Microsoft Office 2003 only

You can export report objects
normally.

You can export report objects
normally.

If the report contains report
objects that were created in a
later version of Microsoft
Office

If you export report objects,
Cognos Disclosure
Management retrieves the
most recently saved version
of the report objects from the
database

You automatically open the
later object in Microsoft
Office 2003 format, and you
might lose features or
formatting specific to the
later version. When you
export the object, you receive
a message in which you
must specify whether you
want to export in Microsoft
Office 2003 format.

To export the object in its
original format, you must
upgrade to the version of
Microsoft Office that was
used to create the report
object.

Viewing and comparing audit trails or snapshots

If you use Microsoft Office 2003, consult the following table to learn about how
different Microsoft Office versions affect audit trails and snapshots.

Restriction: If you work in Microsoft Office 2003 or 2007, you can work with only
one instance of a PowerPoint object at a time. When you view audit trails for
PowerPoint objects, the audit trail content does not load because of this limitation.
You will receive a message in which you can save the logs separately. If you work
in a later version of Microsoft Office, this restriction does not apply.

Table 11. Effect of multiple Microsoft Office versions on audit trails or snapshots

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in
Microsoft Office 2003 only, or
if all snapshots were created
in Microsoft Office 2003 only

You can view and compare
audit trails or snapshots
normally.

You can view and compare
audit trails or snapshots
normally.
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Table 11. Effect of multiple Microsoft Office versions on audit trails or snapshots (continued)

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in a
later version of Microsoft
Office, or if at least one of
the snapshots was created in
a later version of Microsoft
Office

You cannot view or compare
audit trails or snapshots.

To view audit trails or
snapshots, you must install
the compatibility pack, or
upgrade to the version of
Microsoft Office that was
used to create the later report
objects or snapshots.

You can view and compare
audit trails or snapshots.
When you select an audit
trail entry or a snapshot, you
view it in Microsoft Office
2003 format, and you might
not see features or formatting
specific to the later version.
The changes are not saved to
the database.

To view and compare audit
trails or snapshots in their
original format, you must
upgrade to the version of
Microsoft Office that was
used to create the report
object or snapshot.

Generating reports

If you use Microsoft Office 2003, consult the following table to learn about how
different Microsoft Office versions affect generating reports.

Table 12. Effect of multiple Microsoft Office versions on generating reports

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in
Microsoft Office 2003 only

You can generate the report
normally. The report is
generated as a .doc file.

You can generate the report
normally. The report is
generated as a .doc file.

If the report contains report
objects that were created in a
later version of Microsoft
Office

You cannot generate the
report.

To generate the report, you
must install the compatibility
pack, or upgrade to the
version of Microsoft Office
that was used to create the
report object.

You can generate the report.
All later report objects are
converted to Microsoft Office
2003 format on your local
machine, and you might lose
features or formatting
specific to the later version.
However, the version is not
changed in the database.

To generate the report with
report objects in their
original format, you must
upgrade to the version of
Microsoft Office that was
used to create the report
objects.

74 IBM Cognos Disclosure Management XBRL Version 10.2.7: User Guide



Performing report rollovers

If you use Microsoft Office 2003, consult the following table to learn about how
different Microsoft Office versions affect report rollovers.

Table 13. Effect of multiple Microsoft Office versions on report rollovers

Situation
If you use Microsoft Office
2003

If you use Microsoft Office
2003 plus the compatibility
pack

If the report contains report
objects that were created in
Microsoft Office 2003 only

You can perform a report
rollover normally.

You can perform a report
rollover normally.

If the report contains report
objects that were created in a
later version of Microsoft
Office

If you perform a report
rollover, Cognos Disclosure
Management retrieves the
most recently saved version
of the report objects from the
database.

You can perform a report
rollover. All later report
objects are saved in the
format of the version of
Microsoft Office that you
use, and you might lose
features or formatting
specific to the later version.

To roll over the report in its
original format, you must
upgrade to the version of
Microsoft Office that was
used to create the report
objects.

Effect of multiple versions of Microsoft Office if you use Microsoft
Office 2007, 2010 or 2013

When you use Microsoft Office 2007, Microsoft Office 2010, or Microsoft Office
2013, some aspects of your reports in IBM

®

Cognos
®

Disclosure Management
depend on the version of Microsoft Office that was used to create various report
objects. The version of Microsoft Office that you use can affect actions such as
opening reports and report objects, pasting and exporting report objects, and
generating reports.

Opening reports and report objects

Consult the following table to learn about how different Microsoft Office versions
affect opening reports and report objects.

Table 14. Effect of multiple Microsoft Office versions on opening reports and report objects

Situation Effect

If the report contains report objects that
were created in an earlier version of
Microsoft Office

You can open and save reports and report
objects. When you save report objects, you
automatically save them in the format of the
version of Microsoft Office that you use.

If the report contains report objects that
were created only in the version of Microsoft
Office that you use

You can open and save reports and report
objects normally.
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Table 14. Effect of multiple Microsoft Office versions on opening reports and report
objects (continued)

Situation Effect

If the report contains report objects that
were created in a later version of Microsoft
Office

You view the later report object in the
format of the version of Microsoft Office that
you use, and you might not see features or
formatting specific to the later version.
However, no changes are made in the
database.

If a report object is saved in Microsoft Office
2007 and then you open it in a later version
of Microsoft Office and then save, the report
object is saved in Microsoft Office 2007
format, even though you are working in a
later version.

To view a report object in its original format,
you must upgrade to the version of
Microsoft Office that was used to create the
report object.

Copying and pasting report objects

Consult the following table to learn about how different Microsoft Office versions
affect copying and pasting report objects.

Table 15. Effect of multiple Microsoft Office versions on copying and pasting report objects

Situation Effect

If the report contains report objects that
were created in an earlier version of
Microsoft Office

You can copy and paste a report object by
right-clicking the report object and then
using the Copy and Paste options. When
you save a pasted report object, you
automatically save it in the format of the
version of Microsoft Office that you use.

If the report contains report objects that
were created only in the version of Microsoft
Office that you use

You can copy and paste a report object
normally by right-clicking the report object
and then using the Copy and Paste options.

If the report contains report objects that
were created in a later version of Microsoft
Office

You can copy and paste a report object by
right-clicking the report object and then
using the Copy and Paste options. All later
report objects are saved in the format of the
version of Microsoft Office that you use, and
you might lose features or formatting
specific to the later version. The original
report object remains in its original format.

To view and save a pasted report object in
its original format, you must upgrade to the
version of Microsoft Office that was used to
create the report object.

Working with shared objects

Consult the following table to learn about how different Microsoft Office versions
affect shared objects.
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Table 16. Effect of multiple Microsoft Office versions on shared objects

Situation Effect

If the report contains report objects that
were created in an earlier version of
Microsoft Office

You can work with shared objects. All
copied report objects are saved in the format
of the version of Microsoft Office that you
use.

If the report contains report objects that
were created only in the version of Microsoft
Office that you use

You can work with shared objects normally.

If the report contains report objects that
were created in a later version of Microsoft
Office

Report objects are opened in the format of
the version of Microsoft Office that you use.
When you save the report object, you
receive a message in which you must specify
whether you want to save in the format of
the version of Microsoft Office that you use.

Reference
The content cannot be modified. A
linked object actually has no
content, so when an object is
opened, the content is retrieved
from the original source object. This
content opens in the version of
Microsoft Office that is on your
computer, and you might lose
features or formatting specific to
the later version.

Copy The content can be modified
because a copy is treated like any
other report object that has content.
All later shared report objects are
saved in the version of Microsoft
Office that you use, and you might
lose features or formatting specific
to the later version.

To view a shared object in its original
format, you must upgrade to the version of
Microsoft Office that was used to create the
report object.

Exporting report objects

Consult the following table to learn about how different Microsoft Office versions
affect report object exports.

Table 17. Effect of multiple Microsoft Office versions on exporting report objects

Situation Effect

If the report contains report objects that
were created in an earlier version of
Microsoft Office

You can export report objects. All earlier
report objects are saved in the format of the
version of Microsoft Office that you use.

If the report contains report objects that
were created only in the version of Microsoft
Office that you use

You can export report objects normally.
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Table 17. Effect of multiple Microsoft Office versions on exporting report objects (continued)

Situation Effect

If the report contains report objects that
were created in a later version of Microsoft
Office

You can export report objects. All later
report objects are saved in the format of the
version of Microsoft Office that you use, and
you might lose features or formatting
specific to the later version.

To export a report object in its original
format, you must upgrade to the version of
Microsoft Office that was used to create the
report object.

Viewing and comparing audit trails or snapshots

Consult the following table to learn about how different Microsoft Office versions
affect audit trails and snapshots.

Restriction: If you work in Microsoft Office 2003 or 2007, you can work with only
one instance of a PowerPoint object at a time. When you view audit trails for
PowerPoint objects, the audit trail content does not load because of this limitation.
You will receive a message in which you can save the logs separately. If you work
in a later version of Microsoft Office, this restriction does not apply.

Table 18. Effect of multiple Microsoft Office versions on audit trails or snapshots

Situation Effect

If the report contains report objects that
were created in an earlier version of
Microsoft Office, or if the snapshots were
created in an earlier version of Microsoft
Office

You can view and compare audit trails or
snapshots. When you select an audit trail
entry or snapshot, you view it in the format
of the version of Microsoft Office that you
use. The changes are not saved to the
database.

If the report contains report objects that
were created only in the version of Microsoft
Office that you use, or if the snapshots were
created only in the version of Microsoft
Office that you use

You can view and compare audit trails or
snapshots normally.

If the report contains report objects that
were created in a later version of Microsoft
Office, or if at least one of the snapshots was
created in a later version of Microsoft Office

You can view and compare audit trails or
snapshots. When you select an audit trail
entry or a snapshot, you view it in the
format of the version of Microsoft Office that
you use, and you might not see features or
formatting specific to the later version. The
changes are not saved to the database.

To view an audit trail entry or snapshot in
its original format, you must upgrade to the
version of Microsoft Office that was used to
create the report objects in the audit trail or
the snapshot.

Generating reports

Consult the following table to learn about how different Microsoft Office versions
affect report generation.
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Table 19. Effect of multiple Microsoft Office versions on generating reports

Situation Effect

If the report contains report objects that
were created in an earlier version of
Microsoft Office

You can generate the report. All earlier
report objects are saved in the format of the
version of Microsoft Office that you use. The
report is generated as a .docx file.

If the report contains report objects that
were created only in the version of Microsoft
Office that you use

You can generate the report normally. The
report is generated as a .docx file.

If the report contains report objects that
were created in a later version of Microsoft
Office

You can generate the report. All later report
objects are saved in the format of the version
of Microsoft Office that you use, and you
might lose features or formatting specific to
the later version. The report is generated as
a .docx file.

To generate the report in its original format,
you must upgrade to the version of
Microsoft Office that was used to create the
report object.

Performing report rollovers

Consult the following table to learn about how different Microsoft Office versions
affect report rollovers.

Table 20. Effect of multiple Microsoft Office versions on report rollovers

Situation Effect

If the report contains report objects that
were created in an earlier version of
Microsoft Office

You can perform a report rollover. All later
report objects are saved in the format of the
version of Microsoft Office that you use, and
you might lose features or formatting
specific to the later version.

If the report contains report objects that
were created only in the version of Microsoft
Office that you use

You can perform a report rollover normally.

If the report contains report objects that
were created in a later version of Microsoft
Office

You can perform a report rollover. All later
report objects are saved in the format of the
version of Microsoft Office that you use, and
you might lose features or formatting
specific to the later version.

To roll over the report in its original format,
you must upgrade to the version of
Microsoft Office that was used to create the
report object.
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Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON
K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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This Software Offering does not use cookies. However, depending upon the
configurations deployed, this Software Offering may use other technologies to
collect personally identifiable information. These technologies collect each user's
v name
v user name
v password
v profile name
v personally identifiable information other than name, user name, password,

profile name and position

for purposes of
v session management
v authentication
v enhanced user usability
v single sign-on configuration
v usage tracking or functional purposes other than session management,

authentication, enhanced user usability and single sign-on configuration

These technologies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, see IBM's Privacy Policy at http://www.ibm.com/privacy and
IBM's Online Privacy Statement at http://www.ibm.com/privacy/details in the
section entitled "Cookies, Web Beacons and Other Technologies" and the "IBM
Software Products and Software-as-a-Service Privacy Statement" at
http://www.ibm.com/software/info/product-privacy.

Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered

trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.
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Glossary

This glossary provides terms and definitions for
the Cognos Disclosure Management software and
products.

The following cross-references are used in this
glossary:
v See refers you from a nonpreferred term to the

preferred term or from an abbreviation to the
spelled-out form.

v See also refers you to a related or contrasting
term.

For other terms and definitions, see the IBM
Terminology website (opens in new window).

“A” “B” “C” “D” on page 86 “E” on page 86 “F”
on page 87 “H” on page 87 “I” on page 87 “L” on
page 87 “M” on page 87 “N” on page 87 “O” on
page 87 “P” on page 87 “Q” on page 88 “R” on
page 88 “S” on page 88 “T” on page 88 “U” on
page 89 “V” on page 89 “W” on page 89 “X” on
page 89

A
abstract element

An element for which the attribute
abstract in its XML schema declaration
has the value true and which, therefore,
cannot be used in an XML instance
document. See also concrete element.

administrator
A person responsible for administrative
tasks such as access authorization and
content management. Administrators can
also grant levels of authority to users.

application query variable
A query variable that is available for all
reports.

application server
A server program in a distributed
network that provides the execution
environment for an application program.

arc A syntactic structure that represents
relationships in XBRL. Possible
relationships are between pairs of
concepts in a taxonomy, between concepts

and resources in a taxonomy, and
between facts and footnotes in an instance
document.

attachment
A file that is attached to an email message
or other electronic document.

audit report
A report that contains audit history of
report objects.

audit trail
A detailed analysis of all changes that are
made to reports or report objects.

B
bidi See bidirectional.

bidirectional (bidi)
Pertaining to scripts such as Arabic and
Hebrew that generally run from right to
left, except for numbers, which run from
left to right.

bidirectional mapping
A mapping in XBRL in which the element
in either taxonomy can be considered the
source element.

C
client A software program or computer that

requests services from a server.

complex type
A type definition for an XML element that
contains nested structures.

concept
A description of information in XBRL. See
also fact.

concrete element
An element for which the attribute
abstract in its XML schema declaration
has the value of false and which therefore
might appear in an instance document.
See also abstract element.

configuration file
A file that contains the values of
configuration parameters.
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content model
The representation of any data that may
be contained inside an XML element.
There are four kinds of content models:
element content, mixed content, EMPTY
content and ANY content.

context
An element in an XBRL instance
document that defines the entity, period,
and scenario that provide understanding
for the values of items.

CSV file
A text file that contains comma-separated
values. A CSV file is commonly used to
exchange files between database systems
and applications that use different
formats.

custom dashboard
A dashboard that is created by the user
from widgets and various data sources to
meet specific requirements. It is not
supplied with the application. See also
fixed dashboard.

custom group
A group that is used to organize report
objects in a report according to their
purpose or content. All other report
objects are filtered out if they are not
assigned to the custom group.

D
dashboard

An interface that integrates data from a
variety of sources and provides a unified
display of relevant and in-context
information.

database server
A software program that uses a database
manager to provide database services to
other software programs or computers.

data source
The physical connection to a data
repository such as a relational database,
an OLAP cube, or a Microsoft Excel file.

Discoverable Taxonomy Set (DTS)
A collection of taxonomy schemas and
linkbases. The DTS includes all taxonomy
schemas and linkbases that can be
discovered by following links or
references in the taxonomy schemas and
linkbases included in the DTS.

DTS See Discoverable Taxonomy Set.

duplicate item
An item that has the same concept as
another item in the same context under
the same parent, as defined in the XBRL
specification.

E
element

In markup languages, a basic unit
consisting of a start tag, end tag,
associated attributes and their values, and
any text that is contained between the
two.

encryption key
A mathematical value that allows
components to verify that they are in
communication with the expected server.
Encryption keys are based on a public or
private key pair that is created during the
installation process.

entity The business that an XBRL report relates
to.

entity identifier
A string that uniquely identifies a
reporting entity according to an entity
scheme.

entity scheme
A framework for referencing naming
authorities for business entities, in the
form of a namespace URI.

exhibit
A mandatory document that is required
by the regulatory body, along with the
report itself. See also supporting
document.

explicit dimension
A dimension in XBRL whose members are
known and defined before use.

extended link
A link that associates an arbitrary number
of resources. The participating resources
can be any combination of remote and
local.

eXtensible Business Reporting Language
(XBRL)

A communication method for electronic
business reporting.

extension taxonomy
An extension of a base taxonomy that
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includes all the changes that are required
for the specific reporting requirements of
an entity.

F
fact A specific piece of information that is

described by a concept in XBRL. See also
concept, measure.

fixed dashboard
A dashboard that is supplied with the
application to provide report and data
source information in a graphical format.
See also custom dashboard.

footer Text that is formatted to be in the bottom
margin of printed pages in a document.
See also header.

footnote
A supporting piece of XBRL information
that is tied to a fact.

formula linkbase
A collection of functions that can be used
by a number of taxonomies and is not
necessarily tied to a particular taxonomy.

H
header

Text that is formatted to be in the top
margin of printed pages in a document.
See also footer.

hypercube
An XBRL construct that represents
multidimensional data.

I
inline XBRL

A standard for embedding XBRL
fragments into an HTML document.

instance document
An XML file that contains facts as defined
by a taxonomy. Instance documents
contain business reporting data with
associated values and contexts.

item An element in the substitution group for
the XBRL item element. The item contains
the value of the simple fact and a
reference to the context that is required to
interpret that fact.

L
linkbase

A collection of XML Linking Language
(XLink) extended links that can be used
to document the semantics of concepts in
a taxonomy.

locator
An XML element that supplies an
Xpointer reference to the taxonomy
schema element definitions that uniquely
identify each concept.

M
measure

A component that is used to define a unit
in XBRL. For example, the unit km/s
(kilometers per second) contains two
measures: kilometers and seconds. See
also fact.

N
namespace

In XML and XQuery, a uniform resource
identifier (URI) that provides a unique
name to associate with the element,
attribute, and type definitions in an XML
schema or with the names of elements,
attributes, types, functions, and errors in
XQuery expressions.

O
orphan tag

An XBRL tag that has become
disassociated from its data source.

orphan variable
A reference variable that does not contain
an accompanying source declaration in a
report.

P
pivot grid

An area of the screen that is used to view
and interact with the XBRL instance data.

project
A framework for holding the data and
metadata that refers to an XBRL instance
document.
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Q
query A request for information from a database

that is based on specific conditions: for
example, a request for a list of all
customers in a customer table whose
balances are greater than USD1000.

query variable
A variable that is used to filter data
source queries.

R
reference object

A shared object that is referenced within
the same report, or in a different report. A
reference object does not contain its own
content.

reference variable
A variable that is used to hold content for
report automation.

relationship group
A set of relationships between XBRL
concepts.

report object query variable
A variable that is used to filter data
source queries for a particular report
object. After the value of the variable has
been overridden at the report level, it can
be further overridden to filter the result
set for the report object.

report query variable
A variable that is used to filter data
source queries at the report level. The
value of the variable can be overridden to
filter the result set for all report objects
referencing that query.

resource
An XML fragment that is contained
within an extended link that provides
additional information about concepts or
items.

role See relationship group.

S
shared object

A report object that is made available for
its content to be referenced within the
same report or across reports.

silent installation
An installation that does not send
messages to the console but instead stores
messages and errors in log files. A silent
installation can use response files for data
input.

simple type
In the XML, a type that cannot have
element content and cannot carry
attributes. Elements that contain numbers
(and strings, and dates, and so on) but do
not contain any sub-elements are said to
have simple types.

snapshot
The content of a report or report object
captured at a specific moment in time.

supporting document
An additional optional document that a
company chooses to submit along with
the mandatory content. See also exhibit.

T
tag A link between an XBRL fact and its

source data, such as a report object or the
result of a query.

taxonomy
A description of a multidimensional data
store expressed in XML.

taxonomy schema
A core document that, in conjunction with
other artifacts, defines an XBRL taxonomy.

text block
An assembly of one or more sections of
text, which might include escaped HTML,
that is drawn from one or more reporting
objects in XBRL.

transformation set
A sequence of transformations that are
applied consecutively.

tuple An XML structure that is used to group
concepts in an XBRL taxonomy that must
be understood together.

typed dimension
A dimension in XBRL that is composed of
a variable set of members that must
conform to a specific type that is defined
by using XML schema.
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U
unit A quantity that is used as a standard of

measurement. For example, in XBRL, the
unit km/s (kilometers per second)
contains two measures: kilometers and
seconds.

user group
A group consisting of one or more
defined individual users, identified by a
single group name.

V
validation

The checking of data or code for
correctness or for compliance with
applicable standards, rules, and
conventions.

variable
A representation of a changeable value.

W
widget

A graphic element, such as a chart or
grid, that displays a particular type of
information in a dashboard.

workflow
A process that is used to track the
progress of a report object towards
completion.

write-back process
A process that gives users the ability to
edit the data in a query and save the
updated data back to an OLAP source.

X
XBRL See eXtensible Business Reporting

Language.
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Index

Numerics
10-K reports 6
10-Q reports 6
20-F reports 6

A
add-ins

enabling in Excel objects 30
airline reports 7
annual reports 7

B
block tags

See text blocks
board books 7

C
Canadian reporting 6
corporate reporting 7

D
dimensions

viewing in the Tag Inspector tab 18

E
EDGAR HTML

overview 24
elements

edit 28
editing 28

errors
correcting after validation of inline XBRL 58

Excel objects
adding footnotes to tuple tags in 51
adding tags 30
adding text blocks from 39
adding tuple tags 49
deleting footnote tags 43
deleting footnotes from tuples 51
deleting tags 42
deleting tuple tags 50
effect of multiple versions of Microsoft Office on version

2003 70
effect of multiple versions of Microsoft Office on version

2007 75
effect of multiple versions of Microsoft Office on version

2010 75
enabling add-ins 30
file extensions 69
finding tags 32
reusing footnotes from 38
selecting content for footnotes 36

extension taxonomies
overview 21

F
facts

overview 34
filters

Pivot Grid 16
footnotes

adding 36
adding to tuple tags 51
deleting from Excel objects 43
deleting from tuples 51
deleting from Word objects 43
deleting tuple tags 50
overview 20
reusing 38

Form 363 6
Form 41 7

G
generation

inline XBRL content 61
inline XBRL content overview 59
instance documents for entire projects 60
XBRL content overview 59
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I
IBM Cognos Disclosure Management XBRL

features 5
industry reporting 7
inline XBRL

generating content 59, 61
tagging 29
validating content 58
validation 55

instance document
reversing numeric values in 41

interface
Home tab Ribbon for administration tasks 10
Home tab Ribbon for general tasks 10
Pivot Grid ribbon 11
Tag Inspector tab 18
Tuple Explorer ribbon 11

internal reports 7
inverted signs

reversing 41

L
logs

adding comments to 65
viewing 65
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M
Management Discussion and Analysis (MD&A) reports 6
Microsoft Office

overview 69
version 2003 70
version 2007 75
version 2010 75

N
negated tags

reversing the sign of a tag 41
negative tag values

changing to positive 41
new functionality

Version 10.2.2 4
XBRL Version 10.2.2 Fix Pack 1 3
XBRL Version 10.2.2.1 3
XBRL Version 10.2.3 2
XBRL Version 10.2.3.1 1, 2

O
Office

See Microsoft Office
orphan tags

deleting 54
finding 53
overview 52
permanent 52
temporary 52

output
generating inline XBRL content 61
generating instance documents for entire projects 60

P
Pivot Grid

editing XBRL items in 35
filtering 16
hiding fields in 13
moving rows and columns in 13
overview 13
pivoting 16
searching for data in 17
viewing data in 13

positive tag values
changing to negative 41

PowerPoint objects
effect of multiple versions of Microsoft Office on version

2003 70
effect of multiple versions of Microsoft Office on version

2007 75
effect of multiple versions of Microsoft Office on version

2010 75
file extensions 69

projects
opening 22
overview 21
viewing XBRL logs 64

Q
quarterly reports 7

query tags
adding tags 44
deleting tags 47
overview 44
refreshing 46

R
refresh

overview 54
XBRL content for entire projects 55

report objects
types 22

reports
annual 7
Canadian 6
corporate 7
examples 5
industry 7
internal 7
quarterly 7
SEC 64
statutory 6
UK 6

S
search

special syntax 17
SEC

preparing for submission of XBRL to 27
previewing reports 64

Securities and Exchange Commission
See SEC

special search syntax 17
statutory reporting 6

T
Tag Inspector tab

editing XBRL tags in 35
overview 18

tags
adding text blocks from Excel objects 39
adding to Excel objects 30
adding to queries 44
adding to Word objects 33
deleting footnotes 43
deleting from Excel objects 42
deleting from queries 47
deleting from Word objects 42
deleting text blocks 42
finding in Excel objects 32
overview 23, 29
refreshing for queries 46
taxonomies 21
validating content for entire projects 56
validating content for tuples for entire projects 59
viewing content 36

taxonomies
adding tuples from 47
editing elements 28
extension 21
hiding tuples from 48
overview 21
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text blocks
adding from Excel objects 39
adding from Word objects 39
deleting from Excel objects 42
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